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1 Get started
This guide provides details about how to use the printer and how to resolve problems.
• Accessibility
• Eco-Tips
• Understand the printer parts
• Find the printer model number
• Select print media
• Load media
• Configure trays
• Change print settings
• Install the accessories
• Turn the printer off

NOTE: If you are using the printer with a computer running Windows XP Starter
Edition, Windows Vista Starter Edition, or Windows 7 Starter Edition, some features
might not be available. For more information, see .

Accessibility
The printer provides a number of features that make it accessible for people with
disabilities.

Visual
The HP software provided with the printer is accessible for users with visual
impairments or low vision by using your operating system's accessibility options and
features. The software also supports most assistive technology such as screen
readers, Braille readers, and voice-to-text applications. For users who are color blind,
colored buttons and tabs used in the HP software and on the printer control panel have
simple text or icon labels that convey the appropriate action.

Mobility
For users with mobility impairments, the HP software functions can be executed
through keyboard commands. The HP software also supports Windows accessibility
options such as StickyKeys, ToggleKeys, FilterKeys, and MouseKeys. The printer
doors, buttons, paper trays, and paper guides can be operated by users with limited
strength and reach.
Support
For more details about the accessibility of this printer and HP's commitment to product
accessibility, visit HP's Web site at www.hp.com/accessibility.

For accessibility information for Mac OS X, visit the Apple Web site at www.apple.com/
accessibility.
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Eco-Tips
HP is committed to helping customers reduce their environmental footprint. HP has
provided these Eco-Tips to help you focus on ways to assess and reduce the impact of
your printing choices. In addition to specific features in this printer, please visit the HP
Eco Solutions Web site for more information on HP's environmental initiatives.

www.hp.com/hpinfo/globalcitizenship/environment/

• Duplex printing: Use Paper-saving Printing to print two-sided documents with
multiple pages on same sheet to reduce paper usage. For more information, see
Print on both sides (duplexing).

• Energy Savings Information: To determine the ENERGY STAR® qualification
status for this printer, see Power consumption.

• Recycled Materials: For more information regarding recycling of HP products,
please visit:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Understand the printer parts
• Front view
• Control panel
• Back view

Front view

1

7

8

2

3

4

56

9

1 Control panel

2 Output tray
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3 Tray 1

4 Width guides

5 Ink cartridge door

6 Ink cartridges

7 Printhead latch

8 Printheads

9 Tray 2 (Tray 2 is sold as an accessory. For ordering information, see HP supplies and
accessories.)

Control panel

OK

9 10 11

2 8761 43 5

1 Attention light

2 Control panel display

3 Back button

4 OK button

5 Help button

6 Cancel button

7 Resume button and light

8 Power button and light

9 Ink Cartridge Markings

10 Left arrow button

11 Right arrow button

(continued)

Understand the printer parts 7



Back view

1

2 3 4 5

1 Power input

2 Ethernet network port

3 Rear universal serial bus (USB) port

4 Automatic two-sided printing accessory (duplexer)

5 Duplex rear access door latch

Find the printer model number
In addition to the model name that appears on the front of the printer, this printer has
a specific model number. You can use this number when obtaining support and to help
determine which supplies or accessories are available for your printer.

The model number is printed on a label located inside the printer, near the ink
cartridges area.

Select print media
The printer is designed to work well with most types of office media. It is best to test
a variety of print media types before buying large quantities. Use HP media for
optimum print quality. Visit the HP Web site at www.hp.com for more information about
HP media.

HP recommends plain papers with the ColorLok logo for printing
and copying of everyday documents. All papers with the
ColorLok logo are independently tested to meet high standards
of reliability and print quality, and produce documents with crisp,
vivid color, bolder blacks and dry faster than ordinary plain
papers. Look for papers with the ColorLok logo in a variety of
weights and sizes from major paper manufacturers.

This section contains the following topics:

• Recommended papers for printing and copying
• Recommended papers for photo printing
• Tips for selecting and using media

Chapter 1
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Recommended papers for printing and copying
If you want the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing.

Depending on your country/region, some of these papers might not be available.

HP Brochure Paper
HP Superior Inkjet
Paper

These papers are glossy-coated or matte-coated on both sides for
two-sided use. They are the perfect choice for near-photographic
reproductions and business graphics for report covers, special
presentations, brochures, mailers, and calendars.

HP Bright White Inkjet
Paper

HP Bright White Inkjet Paper delivers high-contrast colors and sharp
text. It is opaque enough for two-sided color usage with no show-
through, which makes it ideal for newsletters, reports, and flyers. It
features ColorLok Technology for less smearing, bolder blacks and
vivid colors.

HP Printing Paper HP Printing Paper is a high-quality multifunction paper. It produces
documents that look and feel more substantial than documents
printed on standard multipurpose or copy paper. It features ColorLok
Technology for less smearing, bolder blacks and vivid colors. It is
acid-free for longer lasting documents.

HP Office Paper HP Office Paper is a high-quality multifunction paper. It is suitable for
copies, drafts, memos and other everyday documents. It features
ColorLok Technology for less smearing, bolder blacks and vivid
colors. It is acid-free for longer lasting documents

HP Office Recycled
Paper

HP Office Recycled Paper is a high-quality multifunction paper made
with 30% recycled fiber. It features ColorLok Technology for less
smearing, bolder blacks and vivid colors. It is acid-free for longer
lasting documents.

HP Premium
Presentation Paper
HP Professional Paper

These papers are heavy two-sided matte papers perfect for
presentation, proposals, reports and newsletters. They are
heavyweight for an impressive look and feel.

HP Premium Inkjet
Transparency Film

HP Premium Inkjet Transparency Film makes your color
presentations vivid and even more impressive. This film is easy to
use and handle and dries quickly without smudging.

HP Advanced Photo
Paper

This thick photo paper features an instant-dry finish for easy handling
without smudging. It resists water, smears, fingerprints, and humidity.
Your prints have a look and feel comparable to a store processed
photo. It is available in several sizes, including A4, 8.5 x 11 inch, 10
x 15 cm (4 x 6 inch), 13x18 cm (5 x 7 inch) and two finishes – glossy
or soft gloss (satin matte). It is acid-free for longer lasting documents.

HP Everyday Photo
Paper

Print colorful, everyday snapshots at a low cost, using paper
designed for casual photo printing. This affordable, photo paper dries
quickly for easy handling. Get sharp, crisp images when you use this
paper with any inkjet printer. Available in semi-gloss finish in 8.5 x 11
inch, A4, 4 x 6 inch and 10 x 15 cm. It is acid-free for longer lasting
documents.

To order HP papers and other supplies, go to www.hp.com/buy/supplies. If prompted,
select your country/region, follow the prompts to select your printer, and then click one
of the shopping links on the page.
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NOTE: At this time, some portions of the HP Web site are available in English
only.

Recommended papers for photo printing
If you want the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing.

Depending on your country/region, some of these papers might not be available.

HP Advanced Photo Paper
This thick photo paper features an instant-dry finish for easy handling without
smudging. It resists water, smears, fingerprints, and humidity. Your prints have a look
and feel comparable to a store processed photo. It is available in several sizes,
including A4, 8.5 x 11 inch, 10 x 15 cm (4 x 6 inch), 13 x 18 cm (5 x 7 inch) and two
finishes – glossy or soft gloss (satin matte). It is acid-free for longer lasting documents.

HP Everyday Photo Paper
Print colorful, everyday snapshots at a low cost, using paper designed for casual photo
printing. This affordable, photo paper dries quickly for easy handling. Get sharp, crisp
images when you use this paper with any inkjet printer. Available in semi-gloss finish in
8.5 x 11 inch, A4, 4 x 6 inch and 10 x 15 cm. It is acid-free for longer lasting
documents.

HP Photo Value Packs
HP Photo Value Packs conveniently package Original HP ink cartridges and HP
Advanced Photo Paper to save you time and take the guesswork out of printing
affordable professional photos with your HP printer. Original HP inks and HP Advanced
Photo Paper have been designed to work together so your photos are long lasting and
vivid, print after print. Great for printing out an entire vacation’s worth of photos or
multiple prints to share.

To order HP papers and other supplies, go to www.hp.com/buy/supplies. If prompted,
select your country/region, follow the prompts to select your printer, and then click one
of the shopping links on the page.

NOTE: At this time, some portions of the HP Web site are available in English
only.

Tips for selecting and using media
For the best results, observe the following guidelines.

• Always use media that conforms to the printer specifications. For more information,
see Media specifications.

• Load only one type of media at a time into a tray.
• When loading the trays, make sure the media is loaded correctly. For more

information, see Load media.
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• Do not overload the tray. For more information, see Load media.
• To prevent jams, poor print quality, and other printing problems, avoid loading the

following media in the trays:
Multipart forms
Media that is damaged, curled, or wrinkled
Media with cutouts or perforations
Media that is heavily textured, embossed, or does not accept ink well
Media that is too lightweight or stretches easily
Media that contains staples or clips

Load media
This section provides instructions for loading media into the printer.

This section contains the following topics:

• Load standard-size media
• Load envelopes
• Load cards and photo paper
• Load transparencies
• Load custom-size media

Load standard-size media
This section provides instructions for loading media into the printer.

NOTE: Tray 2 is sold as an accessory. For ordering information, see HP supplies
and accessories.

Use these instructions to load standard media.

To load Tray 1 (main tray)
1. Lift the output tray.

2. Slide the media guides out to the widest setting.
3. Insert the media print-side down in the center of the tray, make sure the media

does not exceed the line marking in the tray. Slide the media guides towards the
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center until they touch the left and right sides of the media, and then gently push
the paper stack to the back of the tray.

NOTE: Do not load paper while the printer is printing.

4. Lower the output tray.
5. Pull out the extension on the output tray.

NOTE: For media longer than 11 inches (279 mm), pull the extension out to
the maximum extended position.

To load Tray 2
1. Pull the tray out of the printer by grasping the front of the tray.

2. Slide the media guides out to the widest setting.

Chapter 1
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3. Insert the media print-side down in the center of the tray, make sure the media
does not exceed the line marking in the tray. Slide the media guides towards the
center until they touch the left and right sides of the media, and then gently push
the paper stack to the back of the tray.

NOTE: Do not load paper while the printer is printing.

4. Gently reinsert the tray.
5. Pull out the extension on the output tray.

NOTE: For media longer than 11 inches (279 mm), pull the extension out to
the maximum extended position.

Load envelopes

To load envelopes
Use these instructions to load an envelope

1. Lift the output tray.
2. Slide the paper width guide out as far as possible.

NOTE: If you are loading larger sized media, pull the input tray to extend it.

3. Load envelopes according to the graphic. Make sure the stack of envelopes does
not exceed the line marking in the tray.

NOTE: Do not load paper while the printer is printing.

4. Slide the media guides in the tray to adjust them for the media size that you have
loaded.

5. Lower the output tray.
6. Pull out the tray extender.
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Load cards and photo paper

To load cards and photo paper
Use these instructions to load photo paper.

1. Lift the output tray.
2. Slide the paper width guide out as far as possible.

NOTE: If you are loading larger sized media, pull the input tray to extend it.

3. Insert the media print-side down in the center of the tray, make sure the media
does not exceed the line marking in the tray. Make sure the stack of media aligns
with the right and back edges of the tray, and does not exceed the line marking in
the tray. If the photo paper has a tab along one edge, make sure the tab is pointing
towards the front of the printer.

NOTE: Do not load paper while the printer is printing.

4. Slide the media guides in the tray to adjust them for the media size that you have
loaded.

5. Lower the output tray.
6. Pull out the tray extender.

Load transparencies

To load transparencies
1. Lift the output tray.
2. Slide the paper width guide out as far as possible.

NOTE: If you are loading larger sized media, pull the input tray to extend it.

3. Insert the transparencies, rough-side or print-side down, in the center of the main
tray. Make sure the adhesive strip is pointing towards the back of the printer and
that the stack of transparencies aligns with the right and back edges of the tray.
Also, make sure the stack does not exceed the line marking in the tray.

NOTE: Do not load paper while the printer is printing.

4. Slide the media guides in the tray to adjust them for the media size that you have
loaded.
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5. Lower the output tray.
6. Pull out the tray extender.

Load custom-size media

To load cards and photo paper
Use these instructions to load custom-size media.

CAUTION: Use only custom-size media that is supported by the printer. For more
information, see Media specifications.

1. Lift the output tray.
2. Slide the paper width guide out as far as possible.

NOTE: If you are loading larger sized media, pull the input tray to extend it.

3. Insert the media print-side down in the center of the main tray. Make sure the stack
of media aligns with the right and back edges of the tray, and does not exceed the
line marking in the tray.

NOTE: Do not load paper while the printer is printing.

4. Slide the media guides in the tray to adjust them for the media size that you have
loaded.

5. Lower the output tray.
6. Pull out the tray extender.
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Configure trays
NOTE: Tray 2 is sold as an accessory. For ordering information, see HP supplies
and accessories.

To configure trays, you must have Tray 2 installed and turned on in the printer
driver.

By default, the device draws media from Tray 1. If Tray 1 is empty, the device draws
media from Tray 2 (if it is installed and loaded with media). You can change this default
setting by using the following features:

• Tray Lock: Use this feature to protect special media such as letterhead or
preprinted media from accidental use. If the device runs out of media while printing
a document, it will not use media from a locked tray to complete the print job.

• Default Tray: Use this feature to determine the first tray from which the device
draws media.

NOTE: To use the Tray Lock and Default Tray settings, you must select the
automatic tray selection option in the device software. If the device is on a network
and you set a Default Tray, the setting will affect all users of the device.

Tray 2 is designed to hold only plain paper.

The following table lists possible ways you can use the tray settings to meet your
printing needs.

I want to... Follow these steps

Load both trays with the same media, and
have the device pick media from one tray if the
other one is empty.

• Load media in Tray 1 and Tray 2. For
more information, see Load media.

• Make sure Tray Lock is disabled.

Have both special media (such as
transparencies or letterhead) and plain paper
loaded in the trays.

• Load special media in Tray 1 and plain
paper in Tray 2.

• Make sure the default tray is set to Tray 2.
• Make sure Tray Lock is set to Tray 1.

Load media in both trays but have the device
pick media from a specific tray first.

• Load media in Tray 1 and Tray 2.
• Make sure Default Tray is set to the

appropriate tray.

To configure the trays
1. Make sure the device is turned on.
2. Perform one of the following:

• Embedded Web server: Click the Settings, tab and click Paper Handling in
the left panel.

• HP Utility (Mac OS X): Click Trays Configuration from the Printer Settings
panel.

3. Change the desired tray setting, and then press OK or Apply.

Chapter 1
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Change print settings
You can change print settings (such as paper size or type) from an application or the
printer driver. Changes made from an application take precedence over changes made
from the printer driver. However, after the application is closed, the settings return to
the defaults configured in the driver.

NOTE: To set print settings for all print jobs, make the changes in the printer
driver.

For more information about the features of the Windows printer driver, see the
online help for the driver. For more information about printing from a specific
application, see the documentation that came with the application.

• To change settings from an application for current jobs (Windows)
• To change default settings for all future jobs (Windows)
• To change settings (Mac OS X)

To change settings from an application for current jobs (Windows)
1. Open the document that you want to print.
2. On the File menu, click Print, and then click Setup, Properties, or Preferences.

(Specific options may vary depending on the application that you are using.)
3. Choose the printing shortcut that you want, and then click OK, Print, or a similar

command.

To change default settings for all future jobs (Windows)
1. Click Start, point to Settings, and then click Printers or Printers and Faxes.

- Or -
Click Start, click Control Panel, and then double-click Printers.

NOTE: If prompted, enter the computer administrator's password.

2. Right-click the printer icon, and then click Properties, Document Defaults, or
Printing Preferences.

3. Change the settings that you want, and then click OK.

To change settings (Mac OS X)
1. On the File menu, click Page Setup.

NOTE: In Mac OS X (v10.5 or v10.6), some applications do not have a Page
Setup menu, it is part of the Print menu.

2. Change the settings that you want (such as paper size), and then click OK.
3. On the File menu, click Print to open the printer driver.
4. Change the settings that you want (such as media type), and then click OK or

Print.
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Install the accessories
This section contains the following topics:

• Install the duplexer
• Install Tray 2
• Turn on accessories in the print driver

Install the duplexer
You can print on both sides of a sheet of paper automatically. For information on using
the duplexer, see Print on both sides (duplexing).

To install the duplexer
Slide the duplexer into the printer until the unit locks into place. Do not press the
buttons on either side of the duplexer when installing the unit; use them only for
removing the unit from the printer.

Install Tray 2
Tray 2 can hold up to 250 sheets of plain paper. For ordering information, see HP
supplies and accessories.

To install Tray 2
1. Unpack the tray, remove the packing tapes and materials, and move the tray to the

prepared location. The surface must be sturdy and level.
2. Turn off the printer, and disconnect the power cord.
3. Set the printer on top of the tray.

CAUTION: Be careful to keep your fingers and hands clear of the bottom of
the printer.

4. Connect the power cord and turn on the printer.
5. Enable Tray 2 in the print driver. For more information, see Turn on accessories in

the print driver.

Turn on accessories in the print driver
• To turn on accessories on Windows computers
• To turn on accessories on Macintosh computers

Chapter 1
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To turn on accessories on Windows computers
1. Click Start, point to Settings, and then click Printers or Printers and Faxes.

- Or -
Click Start, click Control Panel, and then double-click Printers.

2. Right-click the printer icon, and then click Properties.
3. Select the Device Settings tab. Click the accessory that you want to turn on, click

Installed from the drop-down menu, and then click OK.

To turn on accessories on Macintosh computers
The Mac OS automatically turns on all accessories in the printer driver when you install
the printer software. If you add a new accessory later, follow these steps:

1. Open the System Preferences and then select Print & Fax.
2. Select the printer.
3. Click Options & Supplies.
4. Click the Driver tab.
5. Select the options you want to install, and then click OK.

Turn the printer off
Turn the printer off by pressing the Power button located on the printer. Wait until the
power light turns off before unplugging the power cord or turning off a power strip. If
you incorrectly turn the printer off, the print carriage might not return to the correct
position causing problems with the ink cartridges and print quality issues.
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2 Print
Most print settings are automatically handled by the software application. Change the
settings manually only when you want to change print quality, print on specific types of
paper, or use special features. For more information about selecting the best print
media for your documents, see Select print media.

Choose a print job to continue:

Print documents

Print brochures

Print on envelopes

Print photos

Print on special and custom-size paper

Print documents
NOTE: With certain types of paper, you can print on both sides of a sheet of paper
(called “two-sided printing” or “duplex printing”). For more information, see Print on
both sides (duplexing).

Follow the instructions for your operating system.

• Print documents (Windows)
• Print documents (Mac OS X)
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Print documents (Windows)
1. Load paper in the tray. For more information, see Load media.
2. On the File menu in your software application, click Print.
3. Make sure the printer you want to use is selected.
4. To change settings, click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Change the paper orientation on the Finishing tab, and paper source, media type,
paper size, and quality settings on the Paper/Quality tab. To print in black and
white, click the Color tab, and then change the Print in Grayscale option.

6. Click OK.
7. Click Print or OK to begin printing.

Print documents (Mac OS X)
1. Load paper in the tray. For more information, see Load media.
2. From the File menu in your software application, click Print.
3. Make sure the printer you want to use is selected.
4. Change the print settings for the option provided in the pop-up menus, as

appropriate for your project.

NOTE: Click the blue disclosure triangle next to the Printer selection to
access these options.

5. Click Print to begin printing.

Print brochures
Follow the instructions for your operating system.

• Print brochures (Windows)
• Print brochures (Mac OS X)

Print brochures (Windows)

NOTE: To set print settings for all print jobs, make the changes in the HP software
provided with the printer. For more information on the HP software, see Printer
management tools.

1. Load paper in the tray. For more information, see Load media.
2. On the File menu in your software application, click Print.
3. Make sure the printer you want to use is selected.
4. To change settings, click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Change the paper orientation on the Finishing tab, and paper source, media type,
paper size, and quality settings on the Paper/Quality tab. To print in black and
white, click the Color tab, and then change the Print in Grayscale option.

6. Click OK.
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7. Click OK.
8. Click Print to begin printing.

Print brochures (Mac OS X)
1. Load paper in the tray. For more information, see Load media.
2. From the File menu in your software application, click Print.
3. Make sure the printer you want to use is selected.
4. Select the appropriate brochure paper type in the Finishing pop-up menu.
5. Select Best or Normal in the Color/Quality pop-up menu.
6. Select any other print settings that you want, and then click Print to begin printing.

Print on envelopes
When selecting envelopes, avoid envelopes that have a very slick finish, self-stick
adhesives, clasps, or windows. Also, avoid envelopes with thick, irregular, or curled
edges, or areas that are wrinkled, torn, or otherwise damaged.

Make sure the envelopes you load in the printer are tightly constructed and that the
folds are sharply creased.

NOTE: For more information about printing on envelopes, see the documentation
available with the software program you are using.

Follow the instructions for your operating system.

• Print on envelopes (Windows)
• Print on envelopes (Mac OS X)

Print on envelopes (Windows)
1. Load envelopes in the tray. For more information, see Load media.
2. On the File menu in your software application, click Print.
3. Make sure the printer you want to use is selected.
4. To change settings, click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. On the Finishing tab, change the orientation to Landscape.
6. Click Paper/Quality, and then select the appropriate envelope from the Paper Size

drop-down list.

TIP: You can change more options for the print job by using the features
available on the other tabs in the dialog box.

7. Click OK, and then click Print or OK to begin printing.

Print on envelopes (Mac OS X)
1. Load envelopes in the tray. For more information, see Load media.
2. From the File menu in your software application, click Print.
3. Make sure the printer you want to use is selected.
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4. Select the appropriate envelope in the Paper Size pop-up menu.
5. Select the Finishing tab.

NOTE: If your computer is using Mac OS X (v10.5 or v10.6), click the blue
disclosure triangle next to the Printer selection to access these options.

6. Select any other print settings that you want, and then click Print to begin printing.

Print photos
Do not leave unused photo paper in the input tray. The paper might start to curl, which
could reduce the quality of your printout. Photo paper should be flat before printing.

Follow the instructions for your operating system.

• Print photos on photo paper (Windows)
• Print photos on photo paper (Mac OS X)

Print photos on photo paper (Windows)
1. Load paper in the tray. For more information, see Load media.
2. On the File menu in your software application, click Print.
3. Make sure the printer you want to use is selected.
4. To change settings, click the option that opens the printer Properties dialog box.

Depending on your software application, this option might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click OK, and then click Print or OK to begin printing.

Print photos on photo paper (Mac OS X)
1. Load paper in the tray. For more information, see Load media.
2. From the File menu in your software application, click Print.
3. Make sure the printer you want to use is selected.
4. Select the appropriate photo paper type in the Finishing pop-up menu.
5. Select Best or Normal in the Color/Quality pop-up menu.
6. Select any other print settings that you want, and then click Print to begin printing.

Print on special and custom-size paper
If your application supports custom-size paper, set the size in the application before
printing the document. If not, set the size in the print driver. You might need to reformat
existing documents to print them correctly on custom-size paper.

Use only custom-size paper that is supported by the printer. For more information, see
Media specifications.

NOTE: With certain types of paper, you can print on both sides of a sheet of paper
(called “two-sided printing” or “duplex printing”). For more information, see Print on
both sides (duplexing).
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Follow the instructions for your operating system.

• Print on special or custom-size paper (Mac OS X)

Print on special or custom-size paper (Mac OS X)

NOTE: Before you can print on custom-size paper, you must set up the custom
size in the HP software provided with the printer. For instructions, see Set up
custom sizes (Mac OS X).

1. Load the appropriate paper in the tray. For more information, see Load media.
2. From the File menu in your software application, click Print.
3. Make sure the printer you want to use is selected.
4. Select the custom size created in the paper size popup..

Select any other print settings that you want, and then click Print to begin printing.
5. Change any other settings, and then click Print to begin printing.

Set up custom sizes (Mac OS X)
1. From the File menu in your software application, click Print.
2. Select the desired printer in the Format for pop-up menu.
3. Select Manage Custom Sizes in the Paper Size pop-up menu.
4. Click the + on the left side of the screen, double-click Untitled, and type a name for

the new, custom size.
5. In the Width and Height boxes, type the dimensions, and then set the margins, if

you want to customize them.
6. Click OK.

Print on both sides (duplexing)
You can print on both sides of a sheet of media automatically by using the duplexer.

NOTE: The printer driver does not support manual duplexing. Two-sided printing
requires an HP Automatic Two-sided Printing Accessory (duplexer) to be installed
on the printer.

TIP: If the top and bottom margins in your document are smaller than 12 mm (0.47
inches), the document might not print out correct. To print the document correctly,
turn on the fit to margin option in the printer's control panel . To do so, press the OK
button, select Paper Handling, select Fit to Margin, and then select On.

Perform two-sided printing (Windows)
1. Load the appropriate media. For more information, see Guidelines for printing on

both sides of a page and Load media.
2. Make sure the duplexer is installed correctly. For more information, see Install the

duplexer.
3. With a document open, click Print on the File menu, and then select Print on Both

Sides on the Finishing tab.
4. Change any other settings, and then click OK.
5. Print your document.
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Perform two-sided printing (Mac OS X)

NOTE: Follow these instructions to enable two-sided printing and to change
binding options.

Mac OS 10.5. Click Two-Sided Printing under Copies & Pages, and then select
the appropriate binding type.

Mac OS 10.6.On the print dialog box, click to select the Two-Sided check box next
to the Copies and Collated options. If the Two-Sided option is not available, verify
that the duplex accessory is enabled in the print driver. Select the binding type on
the Layout panel.

1. Load the appropriate media. For more information, see Guidelines for printing on
both sides of a page and Load media.

2. Make sure the duplexer is installed correctly. For more information, see Install the
duplexer.

3. Verify that you are using the correct printer and page size in the Page Setup.
4. On the File menu, click Print.
5. Select the option to print on both sides.
6. Change any other settings, and then click Print.
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3 Work with ink cartridges
To ensure the best print quality from the printer, you need to perform some simple
maintenance procedures. This section provides guidelines for handling the ink
cartridges, instructions for replacing the ink cartridges, and aligning and cleaning the
printhead.

This section contains the following topics:

• Information on ink cartridges and the printheads
• Check the estimated ink levels
• Replace the ink cartridges
• Store printing supplies

Information on ink cartridges and the printheads
The following tips help maintain HP ink cartridges and ensure consistent print quality.

• The instructions in this user guide are for replacing ink cartridges, and are not
intended for first time installation.

• If you need to replace an ink cartridge, wait until you have the new ink cartridge
available to install before removing the old cartridge.

CAUTION: Wait until you have a new ink cartridge available before removing
the old ink cartridge. Do not leave the ink cartridge outside of the printer for an
extended period of time.

• Keep all ink cartridges in the original sealed packages until they are needed.
• Store ink cartridges in the same orientation packages hang on store shelves or, if

out of box, with label facing down.
• Be sure to turn off the printer properly. For more information, see Turn the printer

off.
• Store ink cartridges at room temperature (15-35° C or 59-95° F).
• You do not need to replace the cartridges until you are prompted by the printer.
• A significant decrease in print quality might be caused by a clogged printhead.

Possible solutions include cleaning the printheads. Cleaning the printheads uses
some ink.

• Do not clean the printheads unnecessarily. This wastes ink and shortens the life of
the cartridges.
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• Handle ink cartridges carefully. Dropping, jarring, or rough handling during
installation can cause temporary printing problems.

• If you are transporting the printer, do the following to prevent ink leaking from the
printer or other damage from occurring to the printer:

Make sure you turn off the printer by pressing  (Power) button. The printhead
assembly should be parked on the right side of the printer, in the service
station. For more information, see Turn the printer off.
Make sure you leave the ink cartridges and printheads installed.
The printer must be transported sitting flat; it should not be placed on its side,
back, front, or top.

Related topics
• Check the estimated ink levels
• To clean the printheads

Check the estimated ink levels
You can check the estimated ink levels from the printer software or the embedded Web
server. For information about using these tools, see Printer management tools. You
can also print the Printer Status page to view this information (see Understand the
Configuration Page).

NOTE: Ink level warnings and indicators provide estimates for planning purposes
only. When you receive a low-ink warning message, consider having a replacement
cartridge available to avoid possible printing delays. You do not need to replace
cartridges until prompted to do so.

NOTE: If you have installed a refilled or remanufactured cartridge, or a cartridge
that has been used in another printer, the ink level indicator might be inaccurate or
unavailable.

NOTE: Ink from the cartridges is used in the printing process in a number of
different ways, including in the initialization process, which prepares the printer and
cartridges for printing, and in printhead servicing, which keeps print nozzles clear
and ink flowing smoothly. In addition, some residual ink is left in the cartridge after it
is used. For more information, see www.hp.com/go/inkusage.

Replace the ink cartridges
NOTE: For information on recycling used ink supplies, see HP inkjet supplies
recycling program.

If you do not already have replacement ink cartridges for the printer, see HP supplies
and accessories.
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NOTE: At this time, some portions of the HP Web site are available in English
only.

CAUTION: Wait until you have a new ink cartridge available before removing the
old ink cartridge. Do not leave the ink cartridge outside of the printer for an
extended period of time. This can result in damage to both the printer and the ink
cartridge.

To replace the ink cartridges
Use these steps to replace the ink cartridges.

1. Gently pull open the ink cartridge cover.

2. Remove the ink cartridge that requires replacement by grasping it and pulling it
firmly toward you.

3. Remove the new ink cartridge from its package.
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4. Align the cartridge with its color-coded slot and insert the cartridge into the slot.
Press down firmly on the cartridge to ensure proper contact.

5. Close the ink cartridge cover.

Store printing supplies
This section covers the following topics:

• Store ink cartridges
• Store printheads

Store ink cartridges
Ink cartridges can be left in the printer for extended periods of time. If you remove the
ink cartridges, place them in an airtight container, such as a re-sealable plastic bag.

Store printheads
Printheads can be left in the printer for extended periods of time. However, to assure
optimal printhead health, be sure to turn the printer off correctly. For more information,
see Turn the printer off.
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4 Solve a problem
The information in Solve a problem suggests solutions to common problems. If your
printer is not operating correctly and those suggestions did not solve your problem, try
using one of the following support services to obtain assistance.

This section contains the following topics:
• HP support
• General troubleshooting tips and resources
• Solve printing problems
• Solve print quality problems
• Solve paper-feed problems
• Solve printer management problems
• Troubleshoot installation issues
• Understand the Configuration Page
• Understand the network configuration page
• Clear jams

HP support

If you have a problem, follow these steps
1. Check the documentation that came with the printer.
2. Visit the HP online support Web site at www.hp.com/support. HP online support is

available to all HP customers. It is the fastest source for up-to-date printer
information and expert assistance and includes the following features:
• Fast access to qualified online support specialists
• HP software and driver updates for the HP printer
• Valuable troubleshooting information for common problems
• Proactive printer updates, support alerts, and HP newsgrams that are available

when you register the printer
For more information, see Obtain electronic support.

3. Call HP support. Support options and availability vary by printer, country/region,
and language. For more information, see HP support by phone.

Obtain electronic support
To find support and warranty information, go to the HP Web site at www.hp.com/
support. If prompted, select your country/region, and then click Contact HP for
information on calling for technical support.

This Web site also offers technical support, drivers, supplies, ordering information and
other options such as:

• Access online support pages.
• Send HP an email message for answers to your questions.
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• Connect with an HP technician by using online chat.
• Check for HP software updates.

You can also obtain support from the HP software for Windows or Mac OS X, which
provide easy, step-by-step solutions to common printing problems. For more
information, see Printer management tools.

Support options and availability vary by printer, country/region, and language.

HP support by phone
The phone support numbers and associated costs listed here are those in effect at time
of publication and are applicable only for calls made on a land line. Different rates may
apply for mobile phones.

For the most current HP list of telephone support numbers and call costs information,
see www.hp.com/support.

During the warranty period, you may obtain assistance from the HP Customer Care
Center.

NOTE: HP does not provide telephone support for Linux printing. All support is
provided online at the following web site: https://launchpad.net/hplip. Click the Ask
a question button to begin the support process.

The HPLIP Web site does not provide support for Windows or Mac OS X. If you are
using these operating systems, see www.hp.com/support.

This section contains the following topics:

• Before you call
• Phone support period
• Telephone support numbers
• After the phone support period

Before you call
Call HP support while you are in front of the computer and the printer. Be prepared to
provide the following information:

• Model number (for more information, see Find the printer model number)
• Serial number (located on the back or bottom of the printer)
• Messages that appear when the situation occurs
• Answers to these questions:

Has this situation happened before?
Can you re-create it?
Did you add any new hardware or software to your computer at about the time
that this situation began?
Did anything else occur prior to this situation (such as a thunderstorm or
moving the printer)?

HP support 31

http://h20180.www2.hp.com/apps/Lookup?h_lang=[$h_lang]_cc=us&cc=us&h_page=hpcom&lang=en&h_client=S-A-R163-1&h_pagetype=s-001&h_query=HP+Officejet +Pro+8500+A910
https://launchpad.net/hplip
http://h20180.www2.hp.com/apps/Lookup?h_lang=[$h_lang]_cc=us&cc=us&h_page=hpcom&lang=en&h_client=S-A-R163-1&h_pagetype=s-001&h_query=HP+Officejet +Pro+8500+A910


Phone support period
One year of phone support is available in North America, Asia Pacific, and Latin
America (including Mexico).

Telephone support numbers
In many locations, HP provides toll free telephone support during the warranty period.
However, some of the support numbers might not be toll free.

After the phone support period
After the phone support period, help is available from HP at an additional cost. Help
may also be available at the HP online support Web site: www.hp.com/support.
Contact your HP dealer or call the support phone number for your country/region to
learn more about support options.

General troubleshooting tips and resources
NOTE: Many of the following steps require HP software. If you did not install the
HP software, you can install it using the HP software CD included with the printer,
or you can download the HP software from the HP support Web site (www.hp.com/
support).

Try these when you begin troubleshooting a printing problem.

• For a paper jam, see Clear jams.
• For paper-feed problems, such as the paper skew and paper pick, see Solve

paper-feed problems.
• Power light is on and not blinking. When the printer is turned on for the first time, it

takes approximately 12 minutes to initialize it after the ink cartridges are installed.
• Power cord and other cables are working, and are firmly connected to the printer.

Make sure the printer is connected firmly to a functioning alternating current (AC)
power outlet, and is turned on. For voltage requirements, see Electrical
specifications.

• Media is loaded correctly in the input tray and is not jammed in the printer.
• All packing tapes and materials are removed.
• The printer is set as the current or default printer. For Windows, set it as the default

in the Printers folder. For Mac OS X, set it as the default in the Print & Fax section
of the System Preferences. See your computer's documentation for more
information.

• Pause Printing is not selected if you are using a computer running Windows.
• You are not running too many programs when you are performing a task. Close

programs that you are not using or restart the computer before attempting the task
again.
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Solve printing problems
This section contains the following topics:

• The printer shuts down unexpectedly
• Alignment fails
• The printer is not responding (nothing prints)
• Printer takes a long time to print
• Blank or partial page printed
• Something on the page is missing or incorrect
• Placement of the text or graphics is wrong

The printer shuts down unexpectedly

Check the power and power connections
Make sure the printer is connected firmly to a functioning alternating current (AC)
power outlet. For voltage requirements, see Electrical specifications.

Alignment fails
If the alignment process fails, make sure you have loaded unused, plain white paper
into the input tray. If you have colored paper loaded in the input tray when you align the
ink cartridges, the alignment fails.

If the alignment process fails repeatedly, you might have a defective sensor or ink
cartridge. Contact HP support. Go to www.hp.com/support. If prompted, select your
country/region, and then click Contact HP for information on calling for technical
support.

The printer is not responding (nothing prints)

There are print jobs stuck in the print queue
Open the print queue, cancel all documents, and then reboot the computer. Try to print
after the computer reboots. Refer to the Help system for the operating system for more
information.

Check the printer setup
For more information, see General troubleshooting tips and resources.

Check the HP software installation
If the printer is turned off when printing, an alert message should appear on your
computer screen; otherwise, the HP software provided with the printer might not be
installed correctly. To resolve this, uninstall the HP software completely, and then
reinstall the HP software.
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Check the cable connections
• Make sure both ends of the USB cable or Ethernet cable are secure.
• If the printer is connected to a network, check the following:

Check the Link light on the back of the printer.
Make sure you are not using a phone cord to connect the printer.

Check any personal firewall software installed on the computer
The personal software firewall is a security program that protects a computer from
intrusion. However, the firewall might block communication between the computer and
the printer. If there is a problem communicating with the printer, try temporarily
disabling the firewall. If the problem persists, the firewall is not the source of the
communication problem. Re-enable the firewall.

Printer takes a long time to print

Check the system configuration and resources
Make sure the computer meets the minimum system requirements for the printer. For
more information, see System requirements.

Check the HP software settings
Print speed is slower when you select high print-quality settings. To increase the print
speed, select different print settings in the print driver. For more information, see Print.

Blank or partial page printed

Clean the printhead
Complete the printhead cleaning procedure. For more information, see To clean the
printheads. The printhead may need to be cleaned if the printer was turned off
incorrectly.

NOTE: Incorrectly turning off the printer can cause print quality problems like
blank or partial pages. Printhead cleaning can solve these problems, but turning off
the printer correctly can prevent them in the first place. Always turn the printer off
by pressing the Power button on the printer. Wait until the Power light goes out
before unplugging the power cord or turning off a power strip.

Check the media settings
• Make sure you select the correct print quality settings in the printer driver for the

media loaded in the trays.
• Make sure the page settings in the printer driver match the page size of media

loaded in the tray.

More than one page is being picked
For more information on paper-feed problems, see Solve paper-feed problems.
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There is a blank page in the file
Check the file to make sure there is no blank page.

Something on the page is missing or incorrect

Check the Print Quality Diagnostic page
Print a Print Quality Diagnostic page to help you decide whether to run any
maintenance tools to improve the print quality of your printouts. For more information,
see Understand the Configuration Page.

Check the margin settings
Make sure the margin settings for the document do not exceed the printable area of the
printer.

TIP: If you are printing on both sides of a page and the top and bottom margins in
your document are smaller than 12 mm (0.47 inches), the document might not print
out correct. To print the document correctly, turn on the fit to margin option in the
printer's control panel . To do so, press the OK button, select Paper Handling,
select Fit to Margin, and then select On.

Check the color print settings
Make sure Print in Grayscale is not selected in the print driver.

Check the printer location and length of USB cable
High electromagnetic fields (such as those generated by USB cables) can sometimes
cause slight distortions to printouts. Move the printer away from the source of the
electromagnetic fields. Also, it is recommended that you use a USB cable that is less
than 3 meters (9.8 feet) long to minimize the effects of these electromagnetic fields.

Placement of the text or graphics is wrong

Check how the media is loaded
Make sure the media guides fit snugly against the edges of the stack of media, and
make sure the tray is not overloaded. For more information, see Load media.

Check the media size
• Content on a page might be cut off if the document size is larger than the media

that you are using.
• Make sure the media size selected in the printer driver match the size of media

loaded in the tray.

Check the margin settings
If the text or graphics are cut off at the edges of the page, make sure the margin
settings for the document do not exceed the printable area of your printer.

Solve printing problems 35



Check the page-orientation setting
Make sure the media size and page orientation selected in the application match the
settings in the printer driver. For more information, see Print.

Check the printer location and length of USB cable
High electromagnetic fields (such as those generated by USB cables) can sometimes
cause slight distortions to printouts. Move the printer away from the source of the
electromagnetic fields. Also, it is recommended that you use a USB cable that is less
than 3 meters (9.8 feet) long to minimize the effects of these electromagnetic fields.

If the above solutions do not work, the problem may be caused by the inability of the
application to interpret print settings correctly. See the release notes for known
software conflicts, refer to the application's documentation, or contact the software
manufacturer for specific help.

Solve print quality problems
• General print quality troubleshooting
• Meaningless characters print
• Ink is smearing
• Ink is not filling the text or graphics completely
• Output is faded or dull colored
• Colors are printing as black and white
• Wrong colors are printing
• Printout shows bleeding colors
• Colors do not line up correctly
• Text or graphics are streaked
• Something on the page is missing or incorrect
• Printhead maintenance

General print quality troubleshooting

Check the printheads and ink cartridges
Print the print quality diagnostic page on a clean sheet of white paper. Evaluate any
problem areas, and perform the recommended actions. For more information, see
Printhead maintenance.

NOTE: HP cannot guarantee the quality of refilled, remanufactured, or non-HP ink
cartridges.

Check the paper quality
Make sure the media meets HP specifications, and try to print again. For more
information, see Media specifications.
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Check the type of media loaded in the printer
• Make sure the tray supports the type of media you have loaded. For more

information, see Media specifications.
• Make sure you have selected the tray in the print driver that contains the media that

you want to use.

Check the printer location and length of USB cable
It is recommended that you use a USB cable that is less than 3 meters (9.8 feet) long
to minimize the effects of these electromagnetic fields. You can also try to use
a different USB cable to see if the USB cable has failed.

Meaningless characters print
If an interruption occurs to a job that is printing, the printer might not recognize the rest
of the job.

Cancel the print job and wait for the printer to return to the ready state. If the printer
does not return to the ready state, cancel all jobs in the printer driver, power cycle the
printer, and then print the document.

Check the cable connections
If the printer and computer are connected with a USB cable, the problem may be due
to a poor cable connection.
Make sure the cable connections at both ends are secure. If the problem persists, turn
the printer off, disconnect the cable from the printer, turn on the printer without
connecting the cable, and delete any remaining jobs from the print spooler. When the
Power light is on and not flashing, reconnect the cable.

Check the document file
The document file may be damaged. If you can print other documents from the same
application, try printing a backup copy of your document, if available.

Ink is smearing

Check the print settings
• When you print documents that use a lot of ink, allow more time to dry before

handling the printouts. This is especially true for transparencies. In the printer
driver, select the Best print quality, and also increase the ink drying time and
reduce the ink saturation, using the ink volume under the advanced features
(Windows) or ink features (Mac OS X). However, note that decreasing ink
saturation might give printouts a "washed-out" quality.

• Color documents that have rich, blended colors can wrinkle or smear when printed
using the Best print quality. Try using another print mode, such as Normal, to
reduce ink, or use HP Premium Paper designed for printing vivid color documents.
For more information, see Print.
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Check the media type
• Some types of media do not accept ink well. For these types of media, ink dries

more slowly and smearing may occur. For more information, see Media
specifications.

• Make sure that the media in the tray matches the media type selected in the printer
driver.

Ink is not filling the text or graphics completely

Check the media type
Some media types are not suitable for use with the printer. For more information, see
Media specifications.

Check the printheads
Print the print quality diagnostic page on a clean sheet of white paper. Evaluate any
problem areas, and perform the recommended actions. For more information, see
Printhead maintenance.

Output is faded or dull colored

Check the print mode
The Draft or Fast mode in the printer driver allows you to print at a faster rate, which is
good for printing drafts. To get better results, select Normal or Best. For more
information, see Print.

Check the paper type setting
When printing on transparencies or other special media, select the corresponding
media type in the print driver. For more information, see Print on special and custom-
size paper.

Colors are printing as black and white

Check the print settings
Make sure Print in Grayscale is not selected in the printer driver. Open the HP
software included with the printer, click the Advanced tab, and then select Off from the
Print in Grayscale drop-down menu.

Wrong colors are printing

Check the print settings
Make sure Print in Grayscale is not selected in the printer driver. Open the HP
software included with the printer, click the Advanced tab, and then select Off from the
Print in Grayscale drop-down menu.
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Check the printheads
Print the print quality diagnostic page on a clean sheet of white paper. Evaluate any
problem areas, and perform the recommended actions. For more information, see
Printhead maintenance.

Check the print cartridges.
HP cannot guarantee the quality of refilled, remanufactured, or non-HP ink cartridges.

Printout shows bleeding colors

Check the ink cartridges
Make sure you are using genuine HP ink. HP cannot guarantee the quality of refilled,
remanufactured, or non-HP ink cartridges. For ordering information, see Supplies.

Check the printheads
Print the print quality diagnostic page on a clean sheet of white paper. Evaluate any
problem areas, and perform the recommended actions. For more information, see
Printhead maintenance.

Colors do not line up correctly

Check the printheads
Print the print quality diagnostic page on a clean sheet of white paper. Evaluate any
problem areas, and perform the recommended actions. For more information, see
Printhead maintenance.

Check the graphics placement
Use the zoom or print preview feature of your software to check for gaps in the
placement of graphics on the page.

Text or graphics are streaked 

Check the printheads
Print the print quality diagnostic page on a clean sheet of white paper. Evaluate any
problem areas, and perform the recommended actions. For more information, see
Printhead maintenance.

Something on the page is missing or incorrect

Check the printheads
Print the print quality diagnostic page on a clean sheet of white paper. Evaluate any
problem areas, and perform the recommended actions. For more information, see
Printhead maintenance.
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Check the margin settings
Make sure the margin settings for the document do not exceed the printable area of the
printer.

Check the color print settings
Make sure Print in Grayscale is not selected in the print driver.

Printhead maintenance
If printed characters are incomplete, or printouts are streaked, the ink nozzles might be
clogged and you might need to clean the printheads.

When the quality of printouts deteriorates, follow these steps:

1. Check the health of the printheads. For more information, see To check printhead
health.

2. Print the print quality diagnostic page on a clean sheet of white paper. Evaluate any
problem areas, and perform the recommended actions. For more information, see
Printhead maintenance.

3. Clean the printheads. For more information, see To clean the printheads.
4. Replace the printheads if the problems persist after cleaning.

This section covers the following printhead maintenance tasks:

• To check printhead health
• To print the print quality diagnostic page
• To align the printheads
• To calibrate the linefeed
• To clean the printheads
• To clean the printhead contacts manually
• To replace the printheads

To check printhead health
Use one of the following means to check the printhead health. If any printhead has
a Replace status, then perform one or more of the maintenance functions, or clean or
replace the printhead.

• Configuration Page: Print the configuration page on a clean sheet of white paper,
and check the printhead health section. For more information, see Understand the
Configuration Page.

• Embedded Web server: Open the embedded Web server. For more information,
see To open the embedded Web server. Click the Tools tab, and then click Ink
Gauge in the left pane.

• HP Software (Windows): Open the HP software that was included with the printer.
Click the Information tab, and then click Printhead Health.

• HP Utility (Mac OS X): Click Printhead Health from the Information and Support
panel.

To print the print quality diagnostic page
Use the print quality diagnostic page to diagnose issues affecting the print quality. This
helps you decide whether to run any maintenance tools to improve the print quality of
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your printouts. You can also view the ink level information, and the printhead health
status on the page.

NOTE: Before printing the print quality diagnostic page, make sure you load
paper. For more information, see Load media.

Ink level warnings and indicators provide estimates for planning purposes only.
When you receive a low-ink warning message, consider having a replacement
cartridge available to avoid possible printing delays. You do not need to replace
cartridges until prompted to do so.

• Control panel: Press the OK button, select Information and then press the OK
button. Press right arrow  to select Print Quality Page and then press the OK
button.

• Embedded Web server: Click the Tools tab, click Print Quality Toolbox in the
left pane, select Print Quality Report.

• HP Software (Windows): Open the HP software that was included with the printer.
Click the Device Services tab, and then click Print the Print Quality Diagnostic
Page and follow the onscreen instructions.

• HP Utility (Mac OS X): Click Print Quality Diagnostics from the Information and
Support panel.

1

2

3

4
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1 Printer Information: Shows printer information (such as the printer model number, serial
number, and firmware version number), the number of pages printed from the trays and
duplexer, the ink level information, and the printhead health status.

NOTE: Ink level warnings and indicators provide estimates for planning purposes only.
When you receive a low-ink warning message, consider having a replacement cartridge
available to avoid possible printing delays. You do not need to replace cartridges until
prompted to do so.

2 Test Pattern 1: If the lines are not straight and connected, align the printheads. For more
information, see To align the printheads.

3 Test Pattern 2: If there are thin white lines across any of the colored blocks, clean the
printheads. For more information, see To clean the printheads.

NOTE: If there are thin white lines across all the color blocks and thin white lines across
the gray blocks in Test Pattern 3, do NOT clean the printhead. Calibrate the linefeed
instead. For more information, see To calibrate the linefeed.

4 Test Pattern 3: If there are dark lines or white gaps where the arrows are pointing,
calibrate the linefeed. For more information, see To calibrate the linefeed.

To align the printheads
Whenever you replace a printhead, the printer automatically aligns the printheads to
ensure the best print quality. However, if the lines in Test Pattern 1 on the Print Quality
Diagnostic page are not straight and connected, you can start the alignment process
manually. For more information, see Understand the Configuration Page.

NOTE: Before aligning the printheads, make sure you load plain paper. For more
information, see Load media.

• Control panel: Press the OK button, press the right arrow  to select
Maintenance and then press the OK button. Press OK again when Print Quality
appears. Press right arrow  to select Print Alignment and then press the OK
button.

• Embedded Web server: Click the Tools tab, click Print Quality Toolbox in the
left pane, and click Align Printer.

• HP Software (Windows): Open the HP software that was included with the printer.
Click Printer Actions, click Maintenance Tasks, and then click Align Printheads.

• HP Utility (Mac OS X): Click Align from the Information and Support panel.

To calibrate the linefeed
If Test Pattern 3 on the Print Quality Diagnostic page shows white gaps or dark lines,
you need to calibrate the linefeed. For more information, see Understand the
Configuration Page.

• Control panel: Press the OK button, press the right arrow  to select
Maintenance and then press the OK button. Press OK again when Print Quality
appears. Press right arrow  to select Calibrate Linefeed and then press the OK
button.

• Embedded Web server: Click the Tools tab, click Print Quality Toolbox in the
left pane, and click Calibrate Linefeed.
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• HP Software (Windows): Open the HP software that was included with the printer.
Click the Device Services tab, and then click Linefeed Calibration and follow the
onscreen instructions.

• HP Utility (Mac OS X): Click Calibrate Linefeed from the Information and
Support panel.

To clean the printheads
To determine whether the printheads need to be cleaned, print a Print Quality
Diagnostic page. For more information, see Understand the Configuration Page.

NOTE: Cleaning uses ink, so clean the printheads only when necessary.

The cleaning process takes a few minutes. Some noise might be generated in the
process.

Before cleaning the printheads, make sure you load paper. For more information,
see Load media.

• Control panel: Press the OK button, press the right arrow  to select
Maintenance and then press the OK button. Press OK again when Print Quality
appears. Press right arrow  to select Clean Printhead and then press the OK
button.

• Embedded Web server: Click the Tools tab, click Printer Quality Toolbox in the
left pane, and click Clean Printhead.

• HP Utility (Mac OS X): Click Clean from the Information and Support panel.

To clean the printhead contacts manually
After the printheads are installed, you might get a control-panel message telling you
the printer cannot print. If you receive this message, you might need to clean the
electrical contacts on the printheads and in the printer. Make sure there is paper in the
printer before you start. See Load media for more information.

CAUTION: Electrical contacts contain sensitive electronic components that can be
damaged easily.

1. Open the top cover.
2. If the carriage does not move to the left automatically, press and hold the OK

button until the carriage moves to the left. Wait for the carriage to stop moving, and
then unplug the power cord from the printer.
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3. Lift the printhead latch.

4. Lift the handle of the printhead and use it to pull the printhead out of its slot.

5. Obtain clean, dry, soft and lint-free cleaning material. Suitable materials include
paper coffee filters and eyeglass lens cleaning paper.

CAUTION: Do not use water.
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6. Wipe the electrical contacts on the printhead but do not touch the nozzles.

NOTE: The electrical contacts are small copper-color squares, grouped on
one face of the printhead.

The nozzles are on a different face of the printhead. Ink is visible on the
nozzles.

CAUTION: Touching the nozzles can cause permanent nozzle damage.

CAUTION: Ink can permanently mark clothing.

7. After cleaning, place the printhead on a sheet of paper or paper towel. Make sure
the nozzles are facing up and are not in contact with the paper.

8. Clean the electrical contacts in the printhead slot inside the printer with a clean,
dry, soft and lint-free cloth.

9. Plug in the power cord and turn on the printer. The control panel should indicate
that the printhead is missing.

10. Insert the printhead into its color-coded slot (the label on the printhead must match
the label on the printhead latch). Press down firmly on the printhead to ensure
proper contact.

11. Where necessary, repeat the steps for the remaining printheads.
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12. Pull the printhead latch all the way forward, and then press down to ensure that the
latch is engaged correctly. You might have to apply some pressure to engage the
latch.

13. Close the top cover.
14. If the control-panel message remains, repeat the cleaning procedure for the

printhead that corresponds to the message.
15. If the control-panel message remains, replace the printhead which corresponds to

the message.
16. Wait while the printer initializes the printheads and prints the alignment pages. If

the printer does not print the pages, start the alignment process manually. For
more information, see To align the printheads.

To replace the printheads

NOTE: To find out which printheads work with your printer, see Supplies.

Replace the printheads only when the printhead health indicates that the printheads
need replacement. For more information, see To check printhead health.

Use these instructions to replace a printhead.

1. Open the top cover.
2. If the carriage does not move to the left automatically, press and hold the OK

button until the carriage moves to the left. Wait for the carriage to stop moving.
3. Lift the printhead latch.
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4. Lift the handle of a printhead and use it to pull the printhead out of its slot.

5. Before installing a printhead, shake the printhead up and down at least six times
while the printhead is still in its packaging.
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6. Remove the new printhead from its package, and then remove its orange protective
caps.

CAUTION: Do not shake printheads after the caps are removed.

7. Insert the printhead into its color-coded slot (the label on the printhead must match
the label on the printhead latch). Press down firmly on the printhead to ensure
proper contact.

8. Pull the printhead latch all the way forward, and then press down to ensure that the
latch is engaged correctly. You might have to apply some pressure to engage the
latch.

9. Close the top cover.
10. Wait while the printer initializes the printheads and prints the alignment pages. If

the printer does not print the pages, start the alignment process manually. For
more information, see To align the printheads.

Solve paper-feed problems

Media is not supported for the printer or tray
Use only media that is supported for the printer and the tray being used. For more
information, see Media specifications.

Media is not picked up from a tray
• Make sure media is loaded in the tray. For more information, see Load media. Fan

the media before loading.
• Make sure the paper guides are set to the correct markings in the tray for the

media size you are loading. Also make sure the guides are snug, but not tight,
against the stack.

• Make sure media in the tray is not curled. Uncurl paper by bending it in the
opposite direction of the curl.
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• When using thin special media, make sure that the tray is completely loaded. If you
are using special media that is only available in small quantities, try placing the
special media on top of other paper of the same size to help fill the tray. (Some
media is picked up more easily if the tray is full.)

• If you are using thick special media (such as brochure paper), load media so that
the tray is between 1/4 and 3/4 full. If necessary, place the media on top
of other paper of the same size so that the stack height is within this range.

Media is not coming out correctly
• Make sure the output tray extender is fully extended; otherwise, printed pages may

fall off the printer.

• Remove excess media from the output tray. There is a limit to the number of sheets
the tray can hold.

Pages are skewing
• Make sure the media loaded in the trays is aligned to the paper guides. If needed,

reload the media correctly, making sure that the paper guides are aligned correctly.
• Load media into the printer only when it is not printing.

Multiple pages are being picked up
• Fan the media before loading.
• Make sure the paper guides are set to the correct markings in the tray for the

media size you are loading. Also make sure the guides are snug, but not tight,
against the stack.

• Make sure the tray is not overloaded with paper.
• When using thin special media, make sure that the tray is completely loaded. If you

are using special media that is only available in small quantities, try placing the
special media on top of other paper of the same size to help fill the tray. (Some
media is picked up more easily if the tray is full.)

• If you are using thick special media (such as brochure paper), load media so that
the tray is between 1/4 and 3/4 full. If necessary, place the media on top
of other paper of the same size so that the stack height is within this range.

• Use HP media for optimum performance and efficiency.
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Solve printer management problems
This section provides solutions to common problems that involve managing the printer.
This section contains the following topic:

• Embedded Web server cannot be opened

NOTE: To use the embedded EWS, the printer must be connected to a network
using either an Ethernet connection. You cannot use the embedded Web server if
the printer is connected to a computer with a USB cable.

Embedded Web server cannot be opened

Check your network setup
• Make sure you are not using a phone cord or a crossover cable to connect the

printer to the network.
• Make sure the network cable is securely connected to the printer.
• Make sure the network hub, switch, or router is turned on and working correctly.

Check the computer
Make sure the computer that you are using is connected to the network.

NOTE: To use the EWS, the printer must be connected to a network using either
an Ethernet connection. You cannot use the embedded Web server if the printer is
connected to a computer with a USB cable.

Press the OK button, select Information and then press the OK button. Press right
arrow  to select Network Config Page and then press the OK button.

Check your Web browser
• Make sure the Web browser meets the minimum system requirements. For more

information, see System requirements.
• If your Web browser uses any proxy settings to connect to the Internet, try turning

off these settings. For more information, see the documentation available with your
Web browser.

• Make sure JavaScript and cookies are enabled in your Web browser. For more
information, see the documentation available with your Web browser.

Check the printer IP address
• To check the IP address of the printer, obtain the IP address by printing a network

configuration page. Press right arrow Graphic - Right arrow, select Information ,
and then select Network Config Page.

• Ping the printer using the IP address from the command prompt.
For example, if the IP address is 123.123.123.123, type the following at the MS-
DOS prompt:
C:\>Ping 123.123.123.123
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Or, in Mac OS X, use one of the following methods:
Open Terminal (available in the Applications > Utilities folder) and type the
following: ping 123.123.123
Open the Network Utility (available in the Applications > Utilities folder) and
click the Ping tab.

If a reply appears, the IP address is correct. If a time-out response appears, the IP
address is incorrect.

Troubleshoot installation issues
If the following topics do not help, see HP support for information about HP support.

• Hardware installation suggestions
• HP software installation suggestions
• Solve network problems

Hardware installation suggestions

Check the printer
• Make sure that all packing tape and material have been removed from outside and

inside the printer.
• Make sure that the printer is loaded with paper.
• Make sure that no lights are on or blinking except the Ready light, which should be

on. If the Attention light is blinking, check for messages on the printer control panel.

Check the hardware connections
• Make sure that any cords and cables that you are using are in good working order.
• Make sure that the power cord is connected securely to both the printer and to

a working power outlet.

Check the printheads and ink cartridges
• Make sure that all of the printheads and ink cartridges are firmly installed in their

correct, color-coded slot. Press down firmly on each one to ensure proper contact.
The printer cannot work if they are not all installed.

• Make sure that the printhead latch is closed correctly.
• If the display shows a printhead error message, clean the contacts on the

printheads.

HP software installation suggestions

Check the computer system
• Make sure that your computer is running one of the supported operating systems.
• Make sure that the computer meets at least the minimum system requirements.
• In the Windows printer manager, make sure that the USB drivers have not been

disabled.
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Verify installation preliminaries
• Make sure to use the installation CD that contains the correct HP software for your

operating system.
• Before installing HP software, make sure that all other programs are closed.
• If the computer does not recognize the path to the CD-ROM drive that you type,

make sure that you are specifying the correct drive letter.
• If the computer cannot recognize the installation CD in the CD-ROM drive, inspect

the installation CD for damage. You can download the print driver from the HP Web
site (www.hp.com/support).

NOTE: After correcting any problems, run the installation program again.

Solve network problems

General network troubleshooting
• If you are unable to install the HP software, verify that:

All cable connections to the computer and the printer are secure.
The network is operational and the network hub is turned on.
All applications, including virus protection programs, spyware protection
programs, and firewalls, are closed or disabled for computers running
Windows.
Make sure the printer is installed on the same subnet as the computers that use
the printer.
If the installation program cannot discover the printer, print the network
configuration page and enter the IP address manually in the installation
program. For more information, see Understand the network configuration
page.

• If you are using a computer running Windows, make sure that the network ports
created in the print driver match the printer IP address:

Print the printer’s network configuration page.
Click Start, then click Printers or Printers and Faxes.
- Or -
Click Start, click Control Panel, and then double-click Printers.
Right-click the printer icon, click Properties, and then click the Ports tab.
Select the TCP/IP port for the printer, and then click Configure Port.
Compare the IP address listed in the dialog box and make sure it matches the
IP address listed on the network configuration page. If the IP addresses are
different, change the IP address in the dialog box to match the address on the
network configuration page.
Click OK twice to save the settings and close the dialog boxes.

Problems connecting to a wired network
• If the Network light on the printer control panel does not turn on, make sure that all

of the “General network troubleshooting” conditions are met.
• Though it is not recommended that you assign the printer with a static IP address,

you might resolve some installation problems (such as a conflict with a personal
firewall) by doing so.
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To reset the printer's network settings
1. Press the OK button.
2. Press the right arrow  to select Configure Device and then press the OK button.
3. Press the right arrow  to select Restore Factory Setting and then press the OK

button.

NOTE: Resetting the printer’s network settings also resets the printer’s firewall
settings. For more information about configuring the printer’s firewall settings, see

Understand the Configuration Page
Use the Configuration page to view current printer information and ink cartridge status.
Also use the Configuration page to help you troubleshoot problems with the printer.

The Configuration page also contains a log of recent events.

If you need to call HP, it is often useful to print the Configuration page before calling.

1

2

3
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1. Printer Information: Shows printer information (such as the printer name, model
number, serial number, and firmware version number), the accessories that are
installed (such as the duplexer), and the number of pages printed from the trays
and accessories.

2. Ink Cartridge Status: Shows the estimated ink levels (represented in graphical
form as gauges) and the part numbers and expiration dates of the ink cartridges.

NOTE: Ink level warnings and indicators provide estimates for planning
purposes only. When you receive a low-ink warning message, consider having
a replacement cartridge available to avoid possible printing delays. You do not
need to replace cartridges until prompted to do so.

3. Printhead Status: Shows the status of the printhead health and the part numbers,
first-installation dates, and end-of-warranty dates of the printheads, as well as the
accumulated ink usage. The status options for the printhead are: good, fair, and
replace. If the status is “fair,” then the print quality must be monitored, but the
printhead does not need to replaced. If the status is “replace,” then the printhead
must be replaced. 

To print the Configuration page
• Control panel: Press the OK button, select Information and then press the OK

button. Press the right arrow  to select Print Configuration Page and then press
the OK button.

NOTE: For models that are connected to a network, the network configuration
page will also be printed.

• HP Utility (Mac OS X): Click Device Information from the Information and
Support panel, and then click Print Configuration Page.

• Embedded Web Server: Click Tools, click Printer Information in the left panel,
and then click Print Self Test Page.

Understand the network configuration page
If the printer is connected to a network, you can print a network configuration page to
view the network settings for the printer. You can use the network configuration page to
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help troubleshoot network connectivity problems. If you need to call HP, it is often
useful to print this page before calling.

3

1. General Information: Shows information about the current status and active
connection type of the network, and other information, such as the URL of the
embedded Web server.

2. 802.3 Wired: Shows information about the active wired network connection, such
as the IP address, subnet mask, default gateway, as well as the hardware address
of the printer.
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3. Miscellaneous: Shows information about more advanced network settings.
• Port 9100: The printer supports raw IP printing through TCP Port 9100. This

HP-proprietary TCP/IP port on the printer is the default port for printing. It is
accessed by HP software (for example, the HP Standard Port).

• LPD: Line Printer Daemon (LPD) refers to the protocol and programs
associated with line-printer spooling services that may be installed on various
TCP/IP systems.

NOTE: The LPD functionality can be used with any host implementation of
LPD that complies with the RFC 1179 document. The process for
configuring printer spoolers, however, might differ. See your system
documentation for information about configuring these systems.

• Bonjour: Bonjour services (which use mDNS, or Multicast Domain Name
System) are typically used on small networks for IP address and name
resolution (through UDP port 5353), where a conventional DNS server is not
used.

• SLP: Service Location Protocol (SLP) is an Internet standard network protocol
that provides a framework to allow networking applications to discover the
existence, location, and configuration of networked services in enterprise
networks. This protocol simplifies discovery and use of network resources such
as printers, Web servers, fax machines, video cameras, files systems, backup
devices (tape drives), databases, directories, mail servers, calendars.

• Microsoft Web Services: Enable or disable the Microsoft Web Services
Dynamic Discovery (WS Discovery) protocols or Microsoft Web Services for
Devices (WSD) Print services supported on the printer. Disable unused print
services to prevent access through those services.

NOTE: For more information about WS Discovery and WSD Print, visit
www.microsoft.com.

• SNMP: SNMP (Simple Network Management Protocol) is used by network
management applications for printer management. The printer supports
SNMPv1 protocol on IP networks.

• WINS: If you have a Dynamic Host Configuration Protocol (DHCP) server on
your network, the printer automatically obtains its IP address from that server
and registers its name with any RFC 1001 and 1002-compliant dynamic name
services as long as a WINS server IP address has been specified.

4. Connected PC(s): Lists the computers connected to this printer, as well as the last
time these computers accessed the printer.
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To print the Network Configuration page
• Control panel: Press the OK button, select Information and then press the OK

button. Press right arrow  to select Network Configuration Page and then press
the OK button.

NOTE: For models that are connected to a network, the network configuration
page will also be printed.

• HP Utility (Mac OS X): Click Device Information from the Information and
Support panel, and then click Print Network Configuration Page.

• Embedded Web Server: Click the Network tab, click Status in the left panel under
Wired (802.3), and then click Network Configuration Page.

Clear jams
Occasionally, media becomes jammed during a job. Try the following remedies before
you attempt to clear the jam.

• Make sure that you are printing with media that meets specifications. For more
information, see Media specifications.

• Make sure that you are printing with media that is not wrinkled, folded, or damaged.
• Make sure that the printer is clean.
• Make sure that the trays are loaded correctly and are not too full. For more

information, see Load media.

This section contains the following topics:

• Clear paper jams
• Avoid paper jams

Clear paper jams
If the paper was loaded in the input tray, you might need to clear the paper jam from
the duplexer.
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To clear a jam
Use these steps to clear a paper jam.

1. Remove all media from the output tray.

CAUTION: Trying to clear a paper jam from the front of the printer can
damage the print mechanism. Always access and clear paper jams through the
duplexer.

2. Check the duplexer.
a. Push the button on either side of the duplexer, and then remove the panel or

unit.

b. Locate any jammed media inside the printer, grasp it with both hands and then
pull it towards you.

c. If the jam is not there, push the latch on the top of the duplexer and lower its
cover. If the jam is inside, carefully remove it. Close the cover.

d. Reinsert the duplexer into the printer.
3. Open the top cover and remove any debris.
4. If you have not found the jam and have Tray 2 installed, pull out the tray and

remove the jammed media, if possible. If not, do the following:
a. Ensure the printer is turned off and disconnect the power cord.
b. Lift the printer off Tray 2.
c. Remove the jammed media from the bottom of the printer or from Tray 2.
d. Reposition the printer on top of Tray 2.
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5. Open the print carriage access door. If there is paper remaining inside the printer,
ensure the carriage has moved to the right of the printer, free any paper scraps or
wrinkled media, and pull the media towards you through the top of the printer.

WARNING! Do not reach into the printer when it is on and the carriage is
stuck. When you open the print carriage access door, the carriage should return
to its position on the right side of the printer. If it does not move to the right, turn
off the printer before you remove any jam.

6. After clearing the jam, close all covers, turn on the printer (if you turned it off) and
resend the print job.

Avoid paper jams
To help avoid paper jams, follow these guidelines.

• Remove printed papers from the output tray frequently.
• Prevent curled or wrinkled paper by storing all unused paper flat in a re-sealable

bag.
• Ensure that paper loaded in the input tray lays flat and the edges are not bent or

torn.
• Do not combine different paper types and paper sizes in the input tray; the entire

stack of paper in the input tray must be the same size and type.
• Adjust the paper-width guide in the input tray to fit snugly against all paper. Make

sure the paper-width guide does not bend the paper in the input tray.
• Do not force paper too far forward in the input tray.
• Use paper types that are recommended for the printer. For more information, see

Media specifications.
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A Technical information
This section contains the following topics:
• Warranty information
• Printer specifications
• Regulatory information
• Environmental product stewardship program
• Third-party licenses

Warranty information
This section contains the following topics:
• Hewlett-Packard limited warranty statement
• Ink cartridge warranty information
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Hewlett-Packard limited warranty statement

A. Extent of limited warranty
  1. Hewlett-Packard (HP) warrants to the end-user customer that the HP products specified above will be free from defects 

in materials and workmanship for the duration specified above, which duration begins on the date of purchase by the 
customer.

  2. For software products, HP’s limited warranty applies only to a failure to execute programming instructions. HP does not 
warrant that the operation of any product will be interrupted or error free.

  3. HP's limited warranty covers only those defects that arise as a result of normal use of the product, and does not cover 
any other problems, including those that arise as a result of:

   a. Improper maintenance or modification;
   b. Software, media, parts, or supplies not provided or supported by HP;
   c. Operation outside the product's specifications;
   d. Unauthorized modification or misuse.
  4. For HP printer products, the use of a non-HP cartridge or a refilled cartridge does not affect either the warranty to the 

customer or any HP support contract with the customer. However, if printer failure or damage is attributable to the use of 
a non-HP or refilled cartridge or an expired ink cartridge, HP will charge its standard time and materials charges to 
service the printer for the particular failure or damage.

  5. If HP receives, during the applicable warranty period, notice of a defect in any product which is covered by HP's 
warranty, HP shall either repair or replace the product, at HP's option.

  6. If HP is unable to repair or replace, as applicable, a defective product which is covered by HP's warranty, HP shall, 
within a reasonable time after being notified of the defect, refund the purchase price for the product.

  7. HP shall have no obligation to repair, replace, or refund until the customer returns the defective product to HP.
  8. Any replacement product may be either new or like-new, provided that it has functionality at least equal to that of the 

product being replaced.
  9. HP products may contain remanufactured parts, components, or materials equivalent to new in performance.

10. HP's Limited Warranty Statement is valid in any country where the covered HP product is distributed by HP. Contracts 
for additional warranty services, such as on-site service, may be available from any authorized HP service facility in 
countries where the product is distributed by HP or by an authorized importer.

B. Limitations of warranty
TO THE EXTENT ALLOWED BY LOCAL LAW, NEITHER HP NOR ITS THIRD PARTY SUPPLIERS MAKES ANY 
OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED WARRANTIES OR 
CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

C. Limitations of liability
  1. To the extent allowed by local law, the remedies provided in this Warranty Statement are the customer's sole and 

exclusive remedies.
  2. TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH IN 

THIS WARRANTY STATEMENT, IN NO EVENT SHALL HP OR ITS THIRD PARTY SUPPLIERS BE LIABLE FOR 
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON 
CONTRACT, TORT, OR ANY OTHER LEGAL THEORY AND WHETHER ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES.

D. Local law
  1. This Warranty Statement gives the customer specific legal rights. The customer may also have other rights which vary 

from state to state in the United States, from province to province in Canada, and from country to country elsewhere in 
the world.

  2. To the extent that this Warranty Statement is inconsistent with local law, this Warranty Statement shall be deemed 
modified to be consistent with such local law. Under such local law, certain disclaimers and limitations of this Warranty 
Statement may not apply to the customer. For example, some states in the United States, as well as some governments 
outside the United States (including provinces in Canada), may:

   a. Preclude the disclaimers and limitations in this Warranty Statement from limiting the statutory rights of a consumer 
(e.g., the United Kingdom);

   b. Otherwise restrict the ability of a manufacturer to enforce such disclaimers or limitations; or
   c. Grant the customer additional warranty rights, specify the duration of implied warranties which the manufacturer 

cannot disclaim, or allow limitations on the duration of implied warranties.
  3. THE TERMS IN THIS WARRANTY STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO NOT 

EXCLUDE, RESTRICT, OR MODIFY, AND ARE IN ADDITION TO, THE MANDATORY STATUTORY RIGHTS 
APPLICABLE TO THE SALE OF THE HP PRODUCTS TO SUCH CUSTOMERS.

HP Limited Warranty
Dear Customer,
You will find below the name and address of the HP entity responsible for the performance of the HP Limited Warranty in your 
country. 
You may have additional statutory rights against the seller based on your purchase agreement. Those rights are not 
in any way affected by this HP Limited Warranty.
Ireland: Hewlett-Packard Ireland Limited, 63-74 Sir John Rogerson's Quay, Dublin 2  
United Kingdom: Hewlett-Packard Ltd, Cain Road, Bracknell, GB-Berks RG12 1HN 
Malta: Hewlett Packard International Trade BV, Branch 48, Sqaq Nru 2, Triq ix-Xatt, Pieta MSD08, Malta
South Africa: Hewlett-Packard South Africa Ltd, 12 Autumn Street, Rivonia, Sandton, 2128, Republic of South Africa

HP product Duration of limited warranty
Software Media 90 days
Printer 1 year
Print or Ink cartridges  Until the HP ink is depleted or the “end of warranty” date printed 

 on the cartridge has been reached, whichever occurs first. This 
warranty does not cover HP ink products that have been refilled, 
remanufactured, refurbished, misused, or tampered with.

Printheads (only applies to products with customer 1 year 
replaceable printheads)
Accessories 1 year unless otherwise stated
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Ink cartridge warranty information
The HP cartridge warranty is applicable when the product is used in its designated HP printer.
This warranty does not cover HP ink products that have been refilled, remanufactured,
refurbished, misused, or tampered with.
During the warranty period the product is covered as long as the HP ink is not depleted and the
end of warranty date has not been reached. The end of warranty date, in YYYY-MM format, may
be found on the product as indicated:
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Printer specifications
This section contains the following topics:
• Physical specifications
• Product features and capacities
• Processor and memory specifications
• System requirements
• Network protocol specifications
• Embedded Web server specifications
• Media specifications
• Print specifications
• Environmental specifications
• Electrical specifications
• Acoustic emission specifications (print in Draft mode, noise levels per ISO 7779)

Physical specifications

Size (width x height x depth)
Printer with duplexer: 494 x 180 x 479 mm (19.5 x 7.1 x 18.9 inches)
With Tray 2: Adds 66 mm (2.6 inches) to the height of the printer.

Printer weight (does not include printing supplies)
Printer with duplexer: 7.8 kg (17.2 lb)
With Tray 2: Adds 2.6 kg (5.7 lb)

Product features and capacities

Feature Capacity

Connectivity • USB 2.0-compliant high speed
• Wired network

Print method Drop-on-demand thermal inkjet printing

Ink cartridges Four ink cartridges (one each for black, cyan,
magenta, and yellow)

NOTE: Not all ink cartridges are supported in
all countries/regions.

Printheads Two printheads (one black and yellow, and
one magenta and cyan)

Supply yields Visit www.hp.com/go/learnaboutsupplies/ for
more information on estimated ink cartridge
yields.

Printer languages HP PCL 5e, PCL 6, PostScript® 3™ emulation

Font support HP 80 Fonts (includes 45 scalable True Type
fonts, 35 build-in PostScript language fonts
and one bit-mapped line printer font).

Duty cycle Up to 15,000 pages per month
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Processor and memory specifications

Printer processor
360MHz ARM4, ETM (16 bit)

Printer memory
• 256 MB built-in RAM
• 16 MB built-in Flash ROM

System requirements

NOTE: For the most current information about supported operating systems and system
requirements, visit http://www.hp.com/support/.

Client operating systems supported
• Microsoft Windows Vista Business, Enterprise, Home Basic, Home Premium, and Ultimate;

x86 and x64
• Microsoft Windows XP (SP2 and later) Home Edition, and Professional; x86 and x64
• Microsoft Windows 7 Starter, Home Premium, Professional, Enterprise, and Ultimate; x86 and

x64 (Windows 7 Logo Program tested, Windows 7 Release Candidate 1, build 7100)
• Mac OS X v10.5, v10.6

Server operating systems supported
• Microsoft Windows Server 2008 Datacenter (SP1), Enterprise and Standard Editions

Architectures: x86 and x64
Services: Terminal Server, Cluster Server

• Microsoft Windows Server 2003 (SP1 and later) Datacenter, Enterprise, and Standard
Editions

Architectures: x86 and x64
Services: Terminal Server, Cluster Server

• Citrix Presentation Server 4.0 and 4.5
• Citrix XenApp 5.0.1
• Novell NetWare 6.5 SP7
• Novell iPrint Client for Windows 5.12
• Novell iPrint Client for Windows Vista 5.08
• Novell iManager 2.7
• Mac OS X v10.5.8, v10.6: PowerPC G4, G5, or Intel Core processor, 300 MB free hard disk

space

Network protocol specifications

Network operating system compatibility
• Windows XP (32-bit) (Professional and Home Editions), Windows Vista 32-bit and 64-bit

(Ultimate Edition, Enterprise Edition and Business Edition), Windows 7 (32-bit and 64-bit)
• Windows Small Business Server 2003 32-bit and 64-bit, Windows 2003 Server 32-bit and 64-

bit, Windows 2003 Server R2 32-bit and 64-bit (Standard Edition, Enterprise Edition)
• Windows Small Business Server 2008 64-bit, Windows 2008 Server 32-bit and 64-bit,

Windows 2008 Server R2 64-bit (Standard Edition, Enterprise Edition)
• Citrix XenDesktop 4
• Citrix XenServer 5.5
• Mac OS X v.10.5, v10.6
• Microsoft Windows 2003 Server Terminal Services
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• Microsoft Windows 2003 Server Terminal Services with Citrix Presentation Server 4.0
• Microsoft Windows 2003 Server Terminal Services with Citrix Presentation Server 4.5
• Microsoft Windows 2003 Server Terminal Services with Citrix XenApp 5.0
• Microsoft Windows 2003 Server Terminal Services with Citrix Metaframe XP with Feature

Release 3
• Microsoft Windows 2003 Small Business Server Terminal Services
• Microsoft Windows Server 2008 Terminal Services
• Microsoft Windows Small Business Server 2008 Terminal Services
• Microsoft Windows 2008 Server Terminal Services with Citrix XenApp 5.0
• Novell Netware 6.5, Open Enterprise Server 2

Compatible network protocols
TCP/IP

Network management
Embedded Web server (Ability to remotely configure and manage network printers)

Embedded Web server specifications

Requirements
• A TCP/IP-based network (IPX/SPX-based networks are not supported)
• A Web browser (either Microsoft Internet Explorer 7.0 or higher, Mozilla Firefox 3.0 or higher,

Safari 3.0 or higher, or Google Chrome 3.0 or higher)
• A network connection (you cannot use the embedded Web server connected directly to

a computer with a USB cable)
• An Internet connection (required for some features)

NOTE: You can open the embedded Web server without being connected to the
Internet. However, some features are not available.

NOTE: The embedded Web server must be on the same side of a firewall as the printer.

Media specifications
Use these tables to determine the correct media to use with your printer, and determine what
features work with your media.
• Understand specifications for supported media
• Guidelines for printing on both sides of a page

Understand specifications for supported media
Use the tables to determine the correct media to use with your printer, and to determine what
features work with your media.
• Understand supported sizes
• Understand supported media types and weights

Understand supported sizes

NOTE: Tray 2 is available with some models.

NOTE: If you are using the duplexer, the minimum top and bottom margins must be at least
12 mm (0.47 inch).
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Media size Tray 1 Tray 2 Duplexer

Standard media sizes

U.S. Letter (216 x 279 mm; 8.5 x 11
inches)

8.5 x 13 inches (216 x 330 mm)

U.S. Legal (216 x 356 mm; 8.5 x 14
inches)

A4 (210 x 297 mm; 8.3 x 11.7 inches)

U.S. Executive (184 x 267 mm; 7.25 x 10.5
inches)

U.S. Statement (140 x 216 mm; 5.5 x 8.5
inches)

B5 (JIS) (182 x 257 mm; 7.17 x 10.12
inches)

A5 (148 x 210 mm; 5.8 x 8.3 inches)

10 x 15 cm

16K (197 x 273 mm; 7.75 x 10.75 inches)

16K (195 x 270 mm; 7.7 x 10.6 inches)

16K (184 x 260 mm; 7.25 x 10.25 inches)

Envelopes

U.S. #10 Envelope (105 x 241 mm; 4.12
x 9.5 inches)

Monarch Envelope (98 x 191 mm; 3.88
x 7.5 inches)

B5 Envelope (176 x 250 mm; 6.7 x 9.8
inches)

DL Envelope (110 x 220 mm; 4.3 x 8.7
inches)

C5 Envelope (162 x 229 mm; 6.4 x 9
inches)

C6 Envelope (114 x 162 mm; 4.5 x 6.4
inches)

Japanese Envelope Chou #3 (120 x 235
mm; 4.7 x 9.3 inches)

Japanese Envelope Chou #4 (90 x 205
mm; 3.5 x 8.1 inches)
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Media size Tray 1 Tray 2 Duplexer

Cards / Photo Media

Index card (76.2 x 127 mm; 3 x 5 inches)

Index card (102 x 152 mm; 4 x 6 inches)

Index card (127 x 179 mm; 5 x 7 inches)

Index card (127 x 203 mm; 5 x 8 inches)

A6 card (105 x 148.5 mm; 4.13 x 5.83
inches)

Japanese Postcard (100 x 148 mm; 3.94
x 5.83 inches)

Double Japan Postcard Rotated (148
x 200 mm; 5.83 x 7.87 inches)

Other media 

Custom-sized media between 76.2 to 216
mm wide and 127 to 356 mm long (3 to 8.5
inches wide and 5 to 14 inches long)

Understand supported media types and weights

NOTE: Tray 2 is available with some models.

Tray Type Weight Capacity

Tray 1 Paper 60 to 105 g/m2

(16 to 28 lb bond)
Up to 250 sheets of
plain paper
(25 mm or 1 inch
stacked)

Transparencies  Up to 70 sheets
(17 mm or 0.67 inch
stacked)

Photo media 250 g/m2

(66 lb bond)
Up to 100 sheets
(17 mm or 0.67 inch
stacked)

Labels  Up to 100 sheets
(17 mm or 0.67 inch
stacked)

Envelopes 75 to 90 g/m2

(20 to 24 lb bond
envelope)

Up to 30 sheets
(17 mm or 0.67 inch
stacked)

Cards Up to 200 g/m2

(110 lb index)
Up to 80 cards

(continued)
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Tray Type Weight Capacity

Tray 2 Plain paper only 60 to 105 g/m2

(16 to 28 lb bond)
Up to 250 sheets of
plain paper
(25 mm or 1.0 inch
stacked)

Duplexer Paper 60 to 105 g/m2

(16 to 28 lb bond)
Not applicable

Output-bin All supported media  Up to 150 sheets of
plain paper (text
printing)

Guidelines for printing on both sides of a page
• Always use media that conforms to the printer specifications. For more information, see

Media specifications.
• Specify two-sided printing options in your application or in the printer driver.
• Do not print on both sides of transparencies, envelopes, photo paper, glossy media, or paper

lighter than 16 lb bond (60 g/m2) or heavier than 28 lb bond (105 g/m2). Jams might occur with
these media types.

• Several kinds of media require a specific orientation when you print on both sides of a page.
These include letterhead, preprinted paper, and paper with watermarks and prepunched
holes. When you print from a computer running Windows, the printer prints the first side of the
media first. Load the media with the print side facing down.

• For auto-duplexing, when printing finishes on one side of the media, the printer holds the
media and pauses while the ink dries. Once the ink dries, the media is pulled back into the
printer and the second side is printed. When printing is complete, the media is dropped onto
the output tray. Do not grab it before printing is complete.

• You can print on both sides of supported custom-sized media by turning the media over and
feeding it into the printer again. For more information, see Media specifications.

Print specifications

Black print resolution
Up to 600 dpi with pigmented black ink

Color print resolution
Up to 600 dpi

Environmental specifications

Operating environment
Operating temperature: 5° to 40° C (41° to 104° F)
Recommended operating conditions: 15° to 32° C (59° to 90° F)
Recommended relative humidity: 25 to 75% non-condensing

Storage environment
Storage temperature: -40° to 60° C (-40° to 140° F)
Storage relative humidity: Up to 90% non-condensing at a temperature of 60° C (140° F)

Electrical specifications

Power supply
Universal power adapter (external)
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Power requirements
Input voltage: 100 to 240 VAC (± 10%), 50/60 Hz (± 3Hz)
Output voltage: 32 Vdc at 2000 mA

Power consumption
21 watts printing (Draft Mode)

Acoustic emission specifications (print in Draft mode, noise levels per ISO 7779)

Sound pressure (bystander position)
LpAd 54 (dBA)

Sound power
LwAd 6.7 (BA)
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Regulatory information
The printer meets product requirements from regulatory agencies in your country/region.
This section contains the following topics:
• FCC statement
• Notice to users in Korea
• VCCI (Class B) compliance statement for users in Japan
• Notice to users in Japan about the power cord
• Noise emission statement for Germany
• LED indicator statement
• European Union Regulatory Notice
• Gloss of housing of peripheral devices for Germany
• Regulatory model number
• Declaration of conformity

FCC statement

FCC statement

The United States Federal Communications Commission (in 47 CFR 15.105) has specified 
that the following notice be brought to the attention of users of this product. 
This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules.  These limits are designed to provide reason-
able protection against harmful interference in a residential installation.  This equipment 
generates, uses and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications.  
However, there is no guarantee that interference will not occur in a particular installation.  
If this equipment does cause harmful interference to radio or television reception, which can 
be determined by turning the equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures:
• Reorient the receiving antenna.
• Increase the separation between the equipment and the receiver.
• Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
For further information, contact:

Manager of Corporate Product Regulations
Hewlett-Packard Company
3000 Hanover Street
Palo Alto, Ca 94304
(650) 857-1501

Modifications (part 15.21)
The FCC requires the user to be notified that any changes or modifications made to this 
device that are not expressly approved by HP may void the user's authority to operate the 
equipment.
This device complies with Part 15 of the FCC Rules.  Operation is subject to the following 
two conditions:  (1) this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired 
operation.
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Notice to users in Korea

VCCI (Class B) compliance statement for users in Japan

B

VCCI-B

Notice to users in Japan about the power cord

Noise emission statement for Germany

Geräuschemission

LpA < 70 dB am Arbeitsplatz im Normalbetrieb nach DIN 45635 T. 19

LED indicator statement

LED indicator statement
The display LEDs meet the requirements of EN 60825-1.

European Union Regulatory Notice
Products bearing the CE marking comply with the following EU Directives:
• Low Voltage Directive 2006/95/EC
• EMC Directive 2004/108/EC
• Ecodesign Directive 2009/125/EC, where applicable
CE compliance of this product is valid only if powered with the correct CE-marked AC adapter
provided by HP.
If this product has telecommunications functionality, it also complies with the essential
requirements of the following EU Directive:
R&TTE Directive 1999/5/EC
Compliance with these directives implies conformity to applicable harmonized European
standards (European Norms) that are listed in the EU Declaration of Conformity issued by HP for
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this product or product family and available (in English only) either within the product
documentation or at the following web site: www.hp.com/go/certificates (type the product number
in the search field).
The compliance is indicated by one of the following conformity markings placed on the product:

For non-telecommunications
products and for EU harmonized
telecommunications products, such
as Bluetooth® within power class
below 10mW.

For EU non-harmonized
telecommunications products (If
applicable, a 4-digit notified body
number is inserted between CE
and !).

Please refer to the regulatory label provided on the product.
The telecommunications functionality of this product may be used in the following EU and EFTA
countries: Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland,
France, Germany, Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania,
Luxembourg, Malta, Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia,
Spain, Sweden, Switzerland, and United Kingdom.
The telephone connector (not available for all products) is intended for connection to analogue
telephone networks.

Products with wireless LAN devices
Some countries may have specific obligations or special requirements about the operation of
Wireless LAN networks such as indoor use only or restrictions of the channels available. Please
make sure that the country settings of the wireless network are correct.

France
For 2.4-GHz Wireless LAN operation of this product, certain restrictions apply: This product may
be used indoors for the entire 2400-MHz to 2483.5-MHz frequency band (channels 1 to 13). For
outdoor use, only the 2400-MHz to 2454-MHz frequency band (channels 1 to 7) may be used. For
the latest requirements, see www.arcep.fr.
The point of contact for regulatory matters is:
Hewlett-Packard GmbH, Dept./MS: HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen,
GERMANY

Gloss of housing of peripheral devices for Germany

Regulatory model number
For regulatory identification purposes, your product is assigned a Regulatory Model Number. The
Regulatory Model Number for your product is SNPRC-0702-04. This regulatory number should
not be confused with the marketing name (HP Officejet Pro 8000 (A811) Enterprise Printer) or
product number.
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Declaration of conformity
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Environmental product stewardship program
Hewlett-Packard is committed to providing quality products in an environmentally sound manner.
Design for recycling has been incorporated into this product. The number of materials has been
kept to a minimum while ensuring proper functionality and reliability. Dissimilar materials have
been designed to separate easily. Fasteners and other connections are easy to locate, access,
and remove using common tools. High priority parts have been designed to access quickly for
efficient disassembly and repair.
For more information, visit HP’s Commitment to the Environment Web site at:
www.hp.com/hpinfo/globalcitizenship/environment/index.html
This section contains the following topics:
• Paper use
• Plastics
• Material safety data sheets
• Recycling program
• HP inkjet supplies recycling program
• Disposal of waste equipment by users in private households in the European Union
• Power consumption
• Chemical Substances
• RoHS notices (China only)

Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the
ability to identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP Web site at:
www.hp.com/go/msds

Recycling program
HP offers an increasing number of product return and recycling programs in many countries/
regions, and partners with some of the largest electronic recycling centers throughout the world.
HP conserves resources by reselling some of its most popular products. For more information
regarding recycling of HP products, please visit:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program
HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is
available in many countries/regions, and lets you recycle used print cartridges and ink cartridges
free of charge. For more information, go to the following Web site:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/
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Disposal of waste equipment by users in private households in the European Union

Disposal of Waste Equipment by Users in Private Households in the European Union
This symbol on the product or on its packaging indicates that this product must not be disposed of with your other household waste. Instead, it is your responsibility to dispose of your waste 
equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment 
at the time of disposal will help to conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where 
you can drop off your waste equipment for recycling, please contact your local city office, your household waste disposal service or the shop where you purchased the product.
Évacuation des équipements usagés par les utilisateurs dans les foyers privés au sein de l'Union européenne
La présence de ce symbole sur le produit ou sur son emballage indique que vous ne pouvez pas vous débarrasser de ce produit de la même façon que vos déchets courants. 
Au contraire, vous êtes responsable de l'évacuation de vos équipements usagés et, à cet effet, vous êtes tenu de les remettre à un point de collecte agréé pour le recyclage des 
équipements électriques et électroniques usagés. Le tri, l'évacuation et le recyclage séparés de vos équipements usagés permettent de préserver les ressources naturelles et de s'assurer 
que ces équipements sont recyclés dans le respect de la santé humaine et de l'environnement. Pour plus d'informations sur les lieux de collecte des équipements usagés, veuillez contacter 
votre mairie, votre service de traitement des déchets ménagers ou le magasin où vous avez acheté le produit.
Entsorgung von Elektrogeräten durch Benutzer in privaten Haushalten in der EU
Dieses Symbol auf dem Produkt oder dessen Verpackung gibt an, dass das Produkt nicht zusammen mit dem Restmüll entsorgt werden darf. Es obliegt daher Ihrer Verantwortung, das 
Gerät an einer entsprechenden Stelle für die Entsorgung oder Wiederverwertung von Elektrogeräten aller Art abzugeben (z.B. ein Wertstoffhof). Die separate Sammlung und das 
Recyceln Ihrer alten Elektrogeräte zum Zeitpunkt ihrer Entsorgung trägt zum Schutz der Umwelt bei und gewährleistet, dass sie auf eine Art und Weise recycelt werden, die keine 
Gefährdung für die Gesundheit des Menschen und der Umwelt darstellt. Weitere Informationen darüber, wo Sie alte Elektrogeräte zum Recyceln abgeben können, erhalten Sie bei 
den örtlichen Behörden, Wertstoffhöfen oder dort, wo Sie das Gerät erworben haben.
Smaltimento di apparecchiature da rottamare da parte di privati nell'Unione Europea 
Questo simbolo che appare sul prodotto o sulla confezione indica che il prodotto non deve essere smaltito assieme agli altri rifiuti domestici. Gli utenti devono provvedere allo 
smaltimento delle apparecchiature da rottamare portandole al luogo di raccolta indicato per il riciclaggio delle apparecchiature elettriche ed elettroniche. La raccolta e il riciclaggio 
separati delle apparecchiature da rottamare in fase di smaltimento favoriscono la conservazione delle risorse naturali e garantiscono che tali apparecchiature vengano rottamate 
nel rispetto dell'ambiente e della tutela della salute. Per ulteriori informazioni sui punti di raccolta delle apparecchiature da rottamare, contattare il proprio comune di residenza, 
il servizio di smaltimento dei rifiuti locale o il negozio presso il quale è stato acquistato il prodotto.
Eliminación de residuos de aparatos eléctricos y electrónicos por parte de usuarios domésticos en la Unión Europea
Este símbolo en el producto o en el embalaje indica que no se puede desechar el producto junto con los residuos domésticos. Por el contrario, si debe eliminar este tipo de residuo, es 
responsabilidad del usuario entregarlo en un punto de recogida designado de reciclado de aparatos electrónicos y eléctricos. El reciclaje y la recogida por separado de estos residuos 
en el momento de la eliminación ayudará a preservar recursos naturales y a garantizar que el reciclaje proteja la salud y el medio ambiente. Si desea información adicional sobre los 
lugares donde puede dejar estos residuos para su reciclado, póngase en contacto con las autoridades locales de su ciudad, con el servicio de gestión de residuos domésticos o con la 
tienda donde adquirió el producto.
Likvidace vysloužilého zařízení uživateli v domácnosti v zemích EU
Tato značka na produktu nebo na jeho obalu označuje, že tento produkt nesmí být likvidován prostým vyhozením do běžného domovního odpadu. Odpovídáte za to, že vysloužilé 
zařízení bude předáno k likvidaci do stanovených sběrných míst určených k recyklaci vysloužilých elektrických a elektronických zařízení. Likvidace vysloužilého zařízení samostatným 
sběrem a recyklací napomáhá zachování přírodních zdrojů a zajišťuje, že recyklace proběhne způsobem chránícím lidské zdraví a životní prostředí. Další informace o tom, kam můžete 
vysloužilé zařízení předat k recyklaci, můžete získat od úřadů místní samosprávy, od společnosti provádějící svoz a likvidaci domovního odpadu nebo v obchodě, kde jste produkt 
zakoupili.
Bortskaffelse af affaldsudstyr for brugere i private husholdninger i EU
Dette symbol på produktet eller på dets emballage indikerer, at produktet ikke må bortskaffes sammen med andet husholdningsaffald. I stedet er det dit ansvar at bortskaffe affaldsudstyr 
ved at aflevere det på dertil beregnede indsamlingssteder med henblik på genbrug af elektrisk og elektronisk affaldsudstyr. Den separate indsamling og genbrug af dit affaldsudstyr på 
tidspunktet for bortskaffelse er med til at bevare naturlige ressourcer og sikre, at genbrug finder sted på en måde, der beskytter menneskers helbred samt miljøet. Hvis du vil vide mere 
om, hvor du kan aflevere dit affaldsudstyr til genbrug, kan du kontakte kommunen, det lokale renovationsvæsen eller den forretning, hvor du købte produktet.
Afvoer van afgedankte apparatuur door gebruikers in particuliere huishoudens in de Europese Unie
Dit symbool op het product of de verpakking geeft aan dat dit product niet mag worden afgevoerd met het huishoudelijk afval. Het is uw verantwoordelijkheid uw afgedankte apparatuur 
af te leveren op een aangewezen inzamelpunt voor de verwerking van afgedankte elektrische en elektronische apparatuur. De gescheiden inzameling en verwerking van uw afgedankte 
apparatuur draagt bij tot het sparen van natuurlijke bronnen en tot het hergebruik van materiaal op een wijze die de volksgezondheid en het milieu beschermt. Voor meer informatie over 
waar u uw afgedankte apparatuur kunt inleveren voor recycling kunt u contact opnemen met het gemeentehuis in uw woonplaats, de reinigingsdienst of de winkel waar u het product 
hebt aangeschaft.
Eramajapidamistes kasutuselt kõrvaldatavate seadmete käitlemine Euroopa Liidus
Kui tootel või toote pakendil on see sümbol, ei tohi seda toodet visata olmejäätmete hulka. Teie kohus on viia tarbetuks muutunud seade selleks ettenähtud elektri- ja elektroonikaseadmete 
utiliseerimiskohta. Utiliseeritavate seadmete eraldi kogumine ja käitlemine aitab säästa loodusvarasid ning tagada, et käitlemine toimub inimeste tervisele ja keskkonnale ohutult. 
Lisateavet selle kohta, kuhu saate utiliseeritava seadme käitlemiseks viia, saate küsida kohalikust omavalitsusest, olmejäätmete utiliseerimispunktist või kauplusest, kust te seadme 
ostsite.
Hävitettävien laitteiden käsittely kotitalouksissa Euroopan unionin alueella
Tämä tuotteessa tai sen pakkauksessa oleva merkintä osoittaa, että tuotetta ei saa hävittää talousjätteiden mukana. Käyttäjän velvollisuus on huolehtia siitä, että hävitettävä laite 
toimitetaan sähkö- ja elektroniikkalaiteromun keräyspisteeseen. Hävitettävien laitteiden erillinen keräys ja kierrätys säästää luonnonvaroja. Näin toimimalla varmistetaan myös, 
että kierrätys tapahtuu tavalla, joka suojelee ihmisten terveyttä ja ympäristöä. Saat tarvittaessa lisätietoja jätteiden kierrätyspaikoista paikallisilta viranomaisilta, jäteyhtiöiltä tai tuotteen 
jälleenmyyjältä.
Απόρριψη άχρηστων συσκευών στην Ευρωπαϊκή Ένωση
Το παρόν σύμβολο στον εξοπλισμό ή στη συσκευασία του υποδεικνύει ότι το προϊόν αυτό δεν πρέπει να πεταχτεί μαζί με άλλα οικιακά απορρίμματα. Αντίθετα, ευθύνη σας είναι να 
απορρίψετε τις άχρηστες συσκευές σε μια καθορισμένη μονάδα συλλογής απορριμμάτων για την ανακύκλωση άχρηστου ηλεκτρικού και ηλεκτρονικού εξοπλισμού. Η χωριστή συλλογή και 
ανακύκλωση των άχρηστων συσκευών θα συμβάλει στη διατήρηση των φυσικών πόρων και στη διασφάλιση ότι θα ανακυκλωθούν με τέτοιον τρόπο, ώστε να προστατεύεται η υγεία των 
ανθρώπων και το περιβάλλον. Για περισσότερες πληροφορίες σχετικά με το πού μπορείτε να απορρίψετε τις άχρηστες συσκευές για ανακύκλωση, επικοινωνήστε με τις κατά τόπους αρμόδιες 
αρχές ή με το κατάστημα από το οποίο αγοράσατε το προϊόν.
A hulladékanyagok kezelése a magánháztartásokban az Európai Unióban
Ez a szimbólum, amely a terméken vagy annak csomagolásán van feltüntetve, azt jelzi, hogy a termék nem kezelhető együtt az egyéb háztartási hulladékkal. Az Ön feladata, 
hogy a készülék hulladékanyagait eljuttassa olyan kijelölt gyűjtőhelyre, amely az elektromos hulladékanyagok és az elektronikus berendezések újrahasznosításával foglalkozik. 
A hulladékanyagok elkülönített gyűjtése és újrahasznosítása hozzájárul a természeti erőforrások megőrzéséhez, egyúttal azt is biztosítja, hogy a hulladék újrahasznosítása az 
egészségre és a környezetre nem ártalmas módon történik. Ha tájékoztatást szeretne kapni azokról a helyekről, ahol leadhatja újrahasznosításra a hulladékanyagokat, forduljon 
a helyi önkormányzathoz, a háztartási hulladék begyűjtésével foglalkozó vállalathoz vagy a termék forgalmazójához.
Lietotāju atbrīvošanās no nederīgām ierīcēm Eiropas Savienības privātajās mājsaimniecībās
Šis simbols uz ierīces vai tās iepakojuma norāda, ka šo ierīci nedrīkst izmest kopā ar pārējiem mājsaimniecības atkritumiem. Jūs esat atbildīgs par atbrīvošanos no nederīgās ierīces, 
to nododot norādītajā savākšanas vietā, lai tiktu veikta nederīgā elektriskā un elektroniskā aprīkojuma otrreizējā pārstrāde. Speciāla nederīgās ierīces savākšana un otrreizējā pārstrāde 
palīdz taupīt dabas resursus un nodrošina tādu otrreizējo pārstrādi, kas sargā cilvēku veselību un apkārtējo vidi. Lai iegūtu papildu informāciju par to, kur otrreizējai pārstrādei var 
nogādāt nederīgo ierīci, lūdzu, sazinieties ar vietējo pašvaldību, mājsaimniecības atkritumu savākšanas dienestu vai veikalu, kurā iegādājāties šo ierīci.
Europos Sąjungos vartotojų ir privačių namų ūkių atliekamos įrangos išmetimas
Šis simbolis ant produkto arba jo pakuotės nurodo, kad produktas negali būti išmestas kartu su kitomis namų ūkio atliekomis. Jūs privalote išmesti savo atliekamą įrangą atiduodami ją 
į atliekamos elektronikos ir elektros įrangos perdirbimo punktus. Jei atliekama įranga bus atskirai surenkama ir perdirbama, bus išsaugomi natūralūs ištekliai ir užtikrinama, kad įranga 
yra perdirbta žmogaus sveikatą ir gamtą tausojančiu būdu. Dėl informacijos apie tai, kur galite išmesti atliekamą perdirbti skirtą įrangą kreipkitės į atitinkamą vietos tarnybą, namų ūkio 
atliekų išvežimo tarnybą arba į parduotuvę, kurioje pirkote produktą.
Utylizacja zużytego sprzętu przez użytkowników domowych w Unii Europejskiej
Symbol ten umieszczony na produkcie lub opakowaniu oznacza, że tego produktu nie należy wyrzucać razem z innymi odpadami domowymi. Użytkownik jest odpowiedzialny za 
dostarczenie zużytego sprzętu do wyznaczonego punktu gromadzenia zużytych urządzeń elektrycznych i elektronicznych. Gromadzenie osobno i recykling tego typu odpadów 
przyczynia się do ochrony zasobów naturalnych i jest bezpieczny dla zdrowia i środowiska naturalnego. Dalsze informacje na temat sposobu utylizacji zużytych urządzeń można 
uzyskać u odpowiednich władz lokalnych, w przedsiębiorstwie zajmującym się usuwaniem odpadów lub w miejscu zakupu produktu.
Descarte de equipamentos por usuários em residências da União Européia
Este símbolo no produto ou na embalagem indica que o produto não pode ser descartado junto com o lixo doméstico. No entanto, é sua responsabilidade levar os equipamentos 
a serem descartados a um ponto de coleta designado para a reciclagem de equipamentos eletro-eletrônicos. A coleta separada e a reciclagem dos equipamentos no momento do 
descarte ajudam na conservação dos recursos naturais e garantem que os equipamentos serão reciclados de forma a proteger a saúde das pessoas e o meio ambiente. Para obter mais 
informações sobre onde descartar equipamentos para reciclagem, entre em contato com o escritório local de sua cidade, o serviço de limpeza pública de seu bairro ou a loja em que 
adquiriu o produto.
Postup používateľov v krajinách Európskej únie pri vyhadzovaní zariadenia v domácom používaní do odpadu
Tento symbol na produkte alebo na jeho obale znamená, že nesmie by vyhodený s iným komunálnym odpadom. Namiesto toho máte povinnos odovzda toto zariadenie na zbernom 
mieste, kde sa zabezpečuje recyklácia elektrických a elektronických zariadení. Separovaný zber a recyklácia zariadenia určeného na odpad pomôže chráni prírodné zdroje a 
zabezpečí taký spôsob recyklácie, ktorý bude chráni ľudské zdravie a životné prostredie. Ďalšie informácie o separovanom zbere a recyklácii získate na miestnom obecnom úrade, 
vo firme zabezpečujúcej zber vášho komunálneho odpadu alebo v predajni, kde ste produkt kúpili.
Ravnanje z odpadno opremo v gospodinjstvih znotraj Evropske unije
Ta znak na izdelku ali embalaži izdelka pomeni, da izdelka ne smete odlagati skupaj z drugimi gospodinjskimi odpadki. Odpadno opremo ste dolžni oddati na določenem zbirnem 
mestu za recikliranje odpadne električne in elektronske opreme. Z ločenim zbiranjem in recikliranjem odpadne opreme ob odlaganju boste pomagali ohraniti naravne vire in zagotovili, 
da bo odpadna oprema reciklirana tako, da se varuje zdravje ljudi in okolje. Več informacij o mestih, kjer lahko oddate odpadno opremo za recikliranje, lahko dobite na občini, 
v komunalnem podjetju ali trgovini, kjer ste izdelek kupili.
Kassering av förbrukningsmaterial, för hem- och privatanvändare i EU
Produkter eller produktförpackningar med den här symbolen får inte kasseras med vanligt hushållsavfall. I stället har du ansvar för att produkten lämnas till en behörig återvinningsstation 
för hantering av el- och elektronikprodukter. Genom att lämna kasserade produkter till återvinning hjälper du till att bevara våra gemensamma naturresurser. Dessutom skyddas både 
människor och miljön när produkter återvinns på rätt sätt. Kommunala myndigheter, sophanteringsföretag eller butiken där varan köptes kan ge mer information om var du lämnar 
kasserade produkter för återvinning.
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Power consumption
Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is
qualified to the U.S. Environmental Protection Agency’s ENERGY STAR specifications for
imaging equipment. The following mark appears on ENERGY STAR qualified imaging products:

ENERGY STAR is a U.S. registered service mark of the U.S. EPA. As an ENERGY STAR
partner, HP has determined that this product meets ENERGY STAR guidelines for energy
efficiency.
Additional ENERGY STAR qualified imaging product model information is listed at:
www.hp.com/go/energystar

Chemical Substances
HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this
product can be found at: www.hp.com/go/reach

RoHS notices (China only)

Toxic and hazardous substance table
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Third-party licenses
HP Officejet Pro 8000 (A811) third-party licenses

LICENSE.aes-pubdom--crypto0000664034734600000620000000214611061627176015570
0ustar fwbuildfirmware/* rijndael-alg-fst.c
 *
 * @version 3.0 (December 2000)
 *
 * Optimised ANSI C code for the Rijndael cipher (now AES)
 *
 * @author Vincent Rijmen <vincent.rijmen@esat.kuleuven.ac.be>
 * @author Antoon Bosselaers <antoon.bosselaers@esat.kuleuven.ac.be>
 * @author Paulo Barreto <paulo.barreto@terra.com.br>
 *
 * This code is hereby placed in the public domain.
 *
 * THIS SOFTWARE IS PROVIDED BY THE AUTHORS ''AS IS'' AND ANY EXPRESS
 * OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
 * WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
 * ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS OR CONTRIBUTORS BE
 * LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
 * CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
 * SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
 * BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
 * WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
 * OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
 * EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
 */
LICENSE.expat-mit--expat0000664034734600000620000000210411061626726015237 0ustar
fwbuildfirmwareCopyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
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IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
LICENSE.open_ssl--open_ssl0000664034734600000620000002004211061626710015644
0ustar fwbuildfirmwareCopyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

This package is an SSL implementation written
by Eric Young (eay@cryptsoft.com).
The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as
the following conditions are aheared to. The following conditions
apply to all code found in this distribution, be it the RC4, RSA,
lhash, DES, etc., code; not just the SSL code. The SSL documentation
included with this distribution is covered by the same copyright terms
except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in
the code are not to be removed.
If this package is used in a product, Eric Young should be given attribution
as the author of the parts of the library used.
This can be in the form of a textual message at program startup or
in documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:
1. Redistributions of source code must retain the copyright
 notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright
 notice, this list of conditions and the following disclaimer in the
 documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software
 must display the following acknowledgement:
 "This product includes cryptographic software written by
 Eric Young (eay@cryptsoft.com)"
 The word 'cryptographic' can be left out if the rouines from the library
 being used are not cryptographic related :-).
4. If you include any Windows specific code (or a derivative thereof) from 
 the apps directory (application code) you must include an acknowledgement:
 "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
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IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

The licence and distribution terms for any publically available version or
derivative of this code cannot be changed. i.e. this code cannot simply be
copied and put under another distribution licence
[including the GNU Public Licence.]

====================================================================
Copyright (c) 1998-2001 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
 notice, this list of conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright
 notice, this list of conditions and the following disclaimer in
 the documentation and/or other materials provided with the
 distribution.

3. All advertising materials mentioning features or use of this
 software must display the following acknowledgment:
 "This product includes software developed by the OpenSSL Project
 for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
 endorse or promote products derived from this software without
 prior written permission. For written permission, please contact
 openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL"
 nor may "OpenSSL" appear in their names without prior written
 permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following
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 acknowledgment:
 "This product includes software developed by the OpenSSL Project
 for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.
====================================================================

This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com). This product includes software written by Tim
Hudson (tjh@cryptsoft.com).

====================================================================
Copyright (c) 1998-2006 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
 notice, this list of conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright
 notice, this list of conditions and the following disclaimer in
 the documentation and/or other materials provided with the
 distribution.

3. All advertising materials mentioning features or use of this
 software must display the following acknowledgment:
 "This product includes software developed by the OpenSSL Project
 for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
 endorse or promote products derived from this software without
 prior written permission. For written permission, please contact
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 openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL"
 nor may "OpenSSL" appear in their names without prior written
 permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following
 acknowledgment:
 "This product includes software developed by the OpenSSL Project
 for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.
====================================================================

This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com). This product includes software written by Tim
Hudson (tjh@cryptsoft.com).

====================================================================
Copyright 2002 Sun Microsystems, Inc. ALL RIGHTS RESERVED.
ECC cipher suite support in OpenSSL originally developed by 
SUN MICROSYSTEMS, INC., and contributed to the OpenSSL project.

LICENSE.sha2-bsd--nos_crypto0000664034734600000620000000322511061626452016011
0ustar fwbuildfirmware/* FIPS 180-2 SHA-224/256/384/512 implementation
 * Last update: 02/02/2007
 * Issue date: 04/30/2005
 *
 * Copyright (C) 2005, 2007 Olivier Gay <olivier.gay@a3.epfl.ch>
 * All rights reserved.
 *
 * Redistribution and use in source and binary forms, with or without
 * modification, are permitted provided that the following conditions
 * are met:
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 * 1. Redistributions of source code must retain the above copyright
 * notice, this list of conditions and the following disclaimer.
 * 2. Redistributions in binary form must reproduce the above copyright
 * notice, this list of conditions and the following disclaimer in the
 * documentation and/or other materials provided with the distribution.
 * 3. Neither the name of the project nor the names of its contributors
 * may be used to endorse or promote products derived from this software
 * without specific prior written permission.
 *
 * THIS SOFTWARE IS PROVIDED BY THE PROJECT AND CONTRIBUTORS ``AS IS'' AND
 * ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE
 * ARE DISCLAIMED. IN NO EVENT SHALL THE PROJECT OR CONTRIBUTORS BE LIABLE
 * FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL
 * DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS
 * OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT
 * LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
 * OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
 * SUCH DAMAGE.
 */
LICENSE.zlib--zlib0000664034734600000620000000241011061627176014106 0ustar
fwbuildfirmwarezlib.h -- interface of the 'zlib' general purpose compression library
version 1.2.3, July 18th, 2005

Copyright (C) 1995-2005 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied
warranty. In no event will the authors be held liable for any damages
arising from the use of this software.

Permission is granted to anyone to use this software for any purpose,
including commercial applications, and to alter it and redistribute it
freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not
 claim that you wrote the original software. If you use this software
 in a product, an acknowledgment in the product documentation would be
 appreciated but is not required.
2. Altered source versions must be plainly marked as such, and must not be
 misrepresented as being the original software.
3. This notice may not be removed or altered from any source distribution.
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Jean-loup Gailly Mark Adler
jloup@gzip.org madler@alumni.caltech.edu

The data format used by the zlib library is described by RFCs (Request for
Comments) 1950 to 1952 in the files http://www.ietf.org/rfc/rfc1950.txt
(zlib format), rfc1951.txt (deflate format) and rfc1952.txt (gzip format).
license.txt0000664034734600000620000003256211353101155013311 0ustar
fwbuildfirmwareLicenses - maybach_lp1

LICENSE.aes-pubdom--crypto
---------------------
/* rijndael-alg-fst.c
 *
 * @version 3.0 (December 2000)
 *
 * Optimised ANSI C code for the Rijndael cipher (now AES)
 *
 * @author Vincent Rijmen <vincent.rijmen@esat.kuleuven.ac.be>
 * @author Antoon Bosselaers <antoon.bosselaers@esat.kuleuven.ac.be>
 * @author Paulo Barreto <paulo.barreto@terra.com.br>
 *
 * This code is hereby placed in the public domain.
 *
 * THIS SOFTWARE IS PROVIDED BY THE AUTHORS ''AS IS'' AND ANY EXPRESS
 * OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
 * WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
 * ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS OR CONTRIBUTORS BE
 * LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
 * CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
 * SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
 * BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
 * WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
 * OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
 * EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
 */

LICENSE.expat-mit--expat
---------------------
Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to
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permit persons to whom the Software is furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

LICENSE.open_ssl--open_ssl
---------------------
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

This package is an SSL implementation written
by Eric Young (eay@cryptsoft.com).
The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as
the following conditions are aheared to. The following conditions
apply to all code found in this distribution, be it the RC4, RSA,
lhash, DES, etc., code; not just the SSL code. The SSL documentation
included with this distribution is covered by the same copyright terms
except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in
the code are not to be removed.
If this package is used in a product, Eric Young should be given attribution
as the author of the parts of the library used.
This can be in the form of a textual message at program startup or
in documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:
1. Redistributions of source code must retain the copyright
 notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright
 notice, this list of conditions and the following disclaimer in the
 documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software
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 must display the following acknowledgement:
 "This product includes cryptographic software written by
 Eric Young (eay@cryptsoft.com)"
 The word 'cryptographic' can be left out if the rouines from the library
 being used are not cryptographic related :-).
4. If you include any Windows specific code (or a derivative thereof) from 
 the apps directory (application code) you must include an acknowledgement:
 "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

The licence and distribution terms for any publically available version or
derivative of this code cannot be changed. i.e. this code cannot simply be
copied and put under another distribution licence
[including the GNU Public Licence.]

====================================================================
Copyright (c) 1998-2001 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
 notice, this list of conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright
 notice, this list of conditions and the following disclaimer in
 the documentation and/or other materials provided with the
 distribution.

3. All advertising materials mentioning features or use of this
 software must display the following acknowledgment:
 "This product includes software developed by the OpenSSL Project
 for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
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4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
 endorse or promote products derived from this software without
 prior written permission. For written permission, please contact
 openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL"
 nor may "OpenSSL" appear in their names without prior written
 permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following
 acknowledgment:
 "This product includes software developed by the OpenSSL Project
 for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.
====================================================================

This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com). This product includes software written by Tim
Hudson (tjh@cryptsoft.com).

====================================================================
Copyright (c) 1998-2006 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
 notice, this list of conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright
 notice, this list of conditions and the following disclaimer in
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 the documentation and/or other materials provided with the
 distribution.

3. All advertising materials mentioning features or use of this
 software must display the following acknowledgment:
 "This product includes software developed by the OpenSSL Project
 for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
 endorse or promote products derived from this software without
 prior written permission. For written permission, please contact
 openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL"
 nor may "OpenSSL" appear in their names without prior written
 permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following
 acknowledgment:
 "This product includes software developed by the OpenSSL Project
 for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.
====================================================================

This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com). This product includes software written by Tim
Hudson (tjh@cryptsoft.com).

====================================================================
Copyright 2002 Sun Microsystems, Inc. ALL RIGHTS RESERVED.
ECC cipher suite support in OpenSSL originally developed by 
SUN MICROSYSTEMS, INC., and contributed to the OpenSSL project.
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LICENSE.sha2-bsd--nos_crypto
---------------------
/* FIPS 180-2 SHA-224/256/384/512 implementation
 * Last update: 02/02/2007
 * Issue date: 04/30/2005
 *
 * Copyright (C) 2005, 2007 Olivier Gay <olivier.gay@a3.epfl.ch>
 * All rights reserved.
 *
 * Redistribution and use in source and binary forms, with or without
 * modification, are permitted provided that the following conditions
 * are met:
 * 1. Redistributions of source code must retain the above copyright
 * notice, this list of conditions and the following disclaimer.
 * 2. Redistributions in binary form must reproduce the above copyright
 * notice, this list of conditions and the following disclaimer in the
 * documentation and/or other materials provided with the distribution.
 * 3. Neither the name of the project nor the names of its contributors
 * may be used to endorse or promote products derived from this software
 * without specific prior written permission.
 *
 * THIS SOFTWARE IS PROVIDED BY THE PROJECT AND CONTRIBUTORS ``AS IS'' AND
 * ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE
 * ARE DISCLAIMED. IN NO EVENT SHALL THE PROJECT OR CONTRIBUTORS BE LIABLE
 * FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL
 * DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS
 * OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT
 * LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
 * OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
 * SUCH DAMAGE.
 */

LICENSE.zlib--zlib
---------------------
zlib.h -- interface of the 'zlib' general purpose compression library
version 1.2.3, July 18th, 2005

Copyright (C) 1995-2005 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied
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warranty. In no event will the authors be held liable for any damages
arising from the use of this software.

Permission is granted to anyone to use this software for any purpose,
including commercial applications, and to alter it and redistribute it
freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not
 claim that you wrote the original software. If you use this software
 in a product, an acknowledgment in the product documentation would be
 appreciated but is not required.
2. Altered source versions must be plainly marked as such, and must not be
 misrepresented as being the original software.
3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly Mark Adler
jloup@gzip.org madler@alumni.caltech.edu

The data format used by the zlib library is described by RFCs (Request for
Comments) 1950 to 1952 in the files http://www.ietf.org/rfc/rfc1950.txt
(zlib format), rfc1951.txt (deflate format) and rfc1952.txt (gzip format).
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B HP supplies and accessories
This section provides information on HP supplies and accessories for the printer. The information
is subject to changes, visit the HP Web site (www.hpshopping.com) for the latest updates. You
may also make purchases through the Web site.
This section contains the following topics:
• Order printing supplies online
• Supplies

Order printing supplies online
To order supplies online or create a printable shopping list, right-click the printer icon, select
Printing Preference..., select Shop for Supplies in Service tab. The HP software uploads, with
your permission, printer information, including model number, serial number, and estimated ink
levels. The HP supplies that work in your printer are pre-selected. You can change quantities, add
or remove items, and then print the list or purchase online at the HP Store or other online retailers
(options differ by country/region). Cartridge information and links to online shopping also appear
on ink alert messages.
You can also order online by visiting www.hp.com/buy/supplies. If prompted, select your country/
region, follow the prompts to select your printer, and then the supplies you need.

NOTE: Ordering cartridges online is not supported in all countries/regions. However, many
countries have information on ordering by telephone, locating a local store and printing
a shopping list. In addition, you can select the 'How to Buy' option at the top of the
www.hp.com/buy/supplies page to obtain information about purchasing HP products in your
country.

Supplies
• Ink cartridges and printheads
• HP media

Ink cartridges and printheads
Ordering cartridges online is not supported in all countries/regions. However, many countries have
information on ordering by telephone, locating a local store and printing a shopping list. In
addition, you can select the How to Buy option at the top of the www.hp.com/buy/supplies page to
obtain information about purchasing HP products in your country.
Use only the replacement cartridges that have the same cartridge number as the ink cartridge you
are replacing. You can find the cartridge number in the following places:
• In the embedded Web server, by clicking the Tools tab, and then, under Product

Information clicking Ink Gauge. For more information, see Embedded Web server.
• On the label of the ink cartridge you are replacing.
• On the printer status page (see Understand the Configuration Page).

NOTE: Ink level warnings and indicators provide estimates for planning purposes only.
When you receive a low-ink warning message, consider having a replacement cartridge
available to avoid possible printing delays. You do not need to replace cartridges until
prompted to do so.
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HP media
To order media such as HP Premium Paper, go to www.hp.com.

HP recommends plain papers with the ColorLok logo for printing
and copying of everyday documents. All papers with the
ColorLok logo are independently tested to meet high standards
of reliability and print quality, and produce documents with crisp,
vivid color, bolder blacks, and that dry faster than ordinary plain
papers. Look for papers with the ColorLok logo in a variety of
weights and sizes from major paper manufacturers.
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C Network setup
You can manage network settings for the printer through the printer control panel as described in
the next section. Additional advanced settings are available in the embedded Web server (EWS),
a configuration and status tool you access from your Web browser using an existing network
connection to the printer. For more information, see Embedded Web server.

CAUTION: Network settings are provided for your convenience. However, unless you are an
advanced user, you should not change some of these settings (such as the link speed, IP
settings, default gateway, and firewall settings).

This section contains the following topics:
• View and print network settings
• Set link speed
• View IP settings
• Change IP settings
• Configure the printer’s firewall settings
• Reset network settings
• Uninstall and reinstall the HP software

View and print network settings
You can display a summary of the network settings on the printer control panel or the HP software
that came with the printer. You can print a more detailed network configuration page, which lists
all of the important network settings such as the IP address, link speed, DNS, and mDNS. For
more information, see Understand the network configuration page.

Set link speed
You can change the speed at which data is transmitted over the network. The default is
Automatic.
1. Press right arrow , and then select Configure Device.
2. Select I/O Option, then select Link Speed.
3. Press right arrow  to scroll the different link speed and press OK for selection of the speed

that matches your network hardware:
• Automatic
• 10-Full
• 10-Half
• 100-Full
• 100-Half

View IP settings
To view the IP address of the printer:
• Print the network configuration page. For more information, see Understand the network

configuration page.
• Or, open the HP software (Windows), click the Network Settings tab, click the Wired or

Wireless tab (depending on the current connection), and then click IP Settings.
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Change IP settings
The default IP setting for the IP settings is Automatic, which sets the IP settings automatically.
However, if you are an advanced user, you might want to manually change settings such as the IP
address, subnet mask, or the default gateway.

CAUTION: Be careful when manually assigning an IP address. If you enter an invalid IP
address during the installation, your network components cannot connect with the printer.

1. Press right arrow , and then select Configure Device.
2. Select I/O Option, and then select IP Settings.
3. Automatic is shown by default. To change the settings manually, press right arrow  and

OK.
4. The IP address will be shown and press OK to make the changes.
5. Once the changes have been made to all the 4 bytes of the IP address, Subnet Mask will

appear and repeat the same process. The last setting will be Default Gateway.

Configure the printer’s firewall settings
Firewall features provide network-layer security on both IPv4 and IPv6 networks. The firewall
provides simple control of IP addresses that are allowed access.

NOTE: In addition to firewall protection at the network layer, the printer also supports an
SNMPv3 agent at the application layer for management application security, and open secure
sockets layer (SSL) standards at the transport layer for secure client-server applications, such
as client-server authentication or HTTPS Web browsing.

For firewall operation on the printer, you must configure a firewall policy to apply to specified IP
traffic. Firewall policy pages are accessed through the EWS and displayed by your Web browser.
After a policy is configured, it is not activated until you click Apply in the EWS.

Creating and using firewall rules
Firewall rules allow you to control IP traffic. Use firewall rules to allow or drop IP traffic based on
IP addresses and services.
Enter up to ten rules, each rule specifying the host addresses, services, and the action to take for
those addresses and services.
This section contains the following topics:
• Create a firewall rule
• Change the priority of firewall rules
• Change firewall options
• Reset firewall settings
• Limitations to rules, templates, and services

Create a firewall rule
To create a firewall rule, complete the following steps:
1. Open the embedded Web server. For more information, see Embedded Web server.
2. Click the Settings tab, click Firewall Rules.
3. Click New, and then follow the onscreen instructions.

Change the priority of firewall rules
To change the priority in which a firewall rule is used, complete the following steps:
1. Open the embedded Web server. For more information, see Embedded Web server.
2. Click the Settings tab, click Firewall Rules Priority.
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3. Select the priority in which you want the rule to be used from the Rule Precedence list, with 1
having the highest priority and 10 having the lowest priority.

4. Click Apply.

Change firewall options
To change firewall options for the printer, complete the following steps:
1. Open the embedded Web server. For more information, see Embedded Web server.
2. Click the Settings tab, click Firewall Options.
3. Change any settings, and then click Apply.

NOTE: After clicking Apply, the connection to the EWS might be temporarily disrupted for a
short period of time. If the IP address was unchanged, the EWS connection will be enabled
again. However, if the IP address was changed, use the new IP address to open the EWS.

Reset firewall settings
To reset the firewall settings to the factory defaults, restore the printer’s network settings. For
more information, see To reset the printer's network settings.

Limitations to rules, templates, and services
When creating firewall rules, note the following limitations to rules, templates, and services.

Item Limit

Maximum number of rules. 11

Maximum number of Address Templates.
Note the following:
• All IP Addresses Results in two (2)

address template rules. One for all IPv4
addresses, and another for all IPv6
addresses.

• All non link local IPv6 Results in four (4)
address template rules:

:: to
FE7F:FFFF:FFFF:FFFF:FFFF:FFFF:
FFFF:FFFF for both local and remote
addresses
:: to
FE7F:FFFF:FFFF:FFFF:FFFF:FFFF:
FFFF:FFFF for local addresses
FE81:: to
FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:
FFFF:FFFF for remote addresses
FE81:: to
FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:
FFFF:FFFF for local addresses,

12
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Item Limit

:: to
FE7F:FFFF:FFFF:FFFF:FFFF:FFFF:
FFFF:FFFF for remote addresses
FE81:: to
FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:
FFFF:FFFF for both local and remote
addresses

• All Broadcast/Multicast Addresses
Results in four (4) address template rules:

224.0.0.0 to 239.255.255.255 IPv4
local addresses and all IPv4 remote
addresses
A single IPv4 local address, and all
IPv4 remote addresses
255.255.255.255 local address, and
all IPv4 remote addresses
FF00:: / 8 local IPv6 addresses, and
all IPv6 remote addresses

NOTE: To avoid multiple rules for these
predefined address templates, you can create
custom address templates.

Maximum number of user-defined address
templates.

5

Maximum number of services you can add to
a user-defined service template.

NOTE: The predefined All Services template
is not subject to this limitation and includes all
services supported by the print server.

64

Maximum number of services you can add to
the policy.
For example, if a user-defined service
template consists of 64 services, then it is the
only service template you can use.

64

Maximum number of service templates in the
policy.

10

Maximum number of user-defined custom
service templates.

5

Reset network settings
To reset the administrator password and network settings, complete the following steps:
1. Press right arrow Graphic - Right arrow, and then select Network.
2. Press Restore Network Defaults, and then select Yes.

NOTE: Print the network configuration page and verify that the network settings have been
reset. For more information, see Understand the network configuration page.
By default, the network name (SSID) is “hpsetup” and the communication mode is “ad hoc.”

(continued)
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NOTE: Resetting the printer’s network settings also resets the printer’s firewall settings. For
more information about configuring the printer’s firewall settings, see .

Uninstall and reinstall the HP software
If your installation is incomplete, or if you connected the USB cable to the computer before
prompted by the HP software installation screen, you might need to uninstall and then reinstall the
HP software that came with the printer. Do not simply delete the printer application files from your
computer. Make sure to remove them correctly using the uninstall utility provided when you
installed the HP software.

To uninstall from a Windows computer, method 1
1. Disconnect the printer from your computer. Do not connect it to your computer until after you

have reinstalled the HP software.
2. On the computer desktop, click Start, select Programs or All Programs, click HP, click the

printer name, and then click Uninstall.
3. Follow the onscreen instructions.
4. If you are asked whether you would like to remove shared files, click No.

Other programs that use these files might not work correctly if the files are deleted.
5. Restart your computer.

To uninstall from a Windows computer, method 2

NOTE: Use this method if Uninstall is not available in the Windows Start menu.

1. On the computer desktop, click Start, select Settings, click Control Panel, and then click
Add/Remove Programs.
- Or -
Click Start, click Control Panel, and then double-click Programs and Features.

2. Select the printer name, and then click Change/Remove or Uninstall/Change.
Follow the onscreen instructions.

3. Disconnect the printer from your computer.
4. Restart your computer.

NOTE: It is important that you disconnect the printer before restarting your computer.
Do not connect the printer to your computer until after you have reinstalled the HP
software.

To reinstall in a Windows computer
1. Insert the HP software CD into your computer's CD drive, and follow the onscreen

instructions.
2. Connect the printer when the HP software prompts you to connect it to the computer.
3. Press the Power button to turn the printer on.

After connecting and turning on the printer, you might have to wait several minutes for all of
the Plug and Play events to complete.

4. Follow the onscreen instructions.

To uninstall from a Macintosh computer, method 1
1. Open the HP Utility. For instructions, see Open HP Utility.
2. Click the Application icon on the toolbar.
3. Double click HP Uninstaller, and then click Continue.
4. Select the product to uninstall, and then click Uninstall.
5. When prompted, type the correct administrator’s name and password, and then click OK.
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6. Follow the onscreen instructions.
7. When the HP Uninstaller finishes, restart your computer.

To uninstall from a Macintosh computer, method 2
1. Open the Finder, select Applications, and then select Hewlett-Packard.
2. Double-click HP Uninstaller, and then click Continue.
3. When prompted, type the correct administrator’s name and password, and then click OK.
4. Follow the onscreen instructions.
5. When the HP Uninstaller finishes, restart your computer.

To reinstall in a Macintosh computer
1. Insert the HP software CD into your computer's CD drive.
2. On the desktop, open the CD, and then double-click HP Installer.
3. Follow the onscreen instructions.

Uninstall and reinstall the HP software 97



D Printer management tools
This section contains the following topics:
• HP Utility (Mac OS X)
• Embedded Web server

HP Utility (Mac OS X)
The HP Utility contains tools to configure print settings, calibrate the printer, order supplies online,
and find Web site support information.

NOTE: On a Macintosh computer, the features available in the HP Utility vary depending on
the selected printer.
Ink level warnings and indicators provide estimates for planning purposes only. When you
receive a low-ink warning message, consider having a replacement cartridge available to
avoid possible printing delays. You do not need to replace cartridges until prompted to do so.

TIP: When the HP Utility is opened, you can gain access to the Dock menu shortcuts by
selecting and holding the mouse button over the appropriate icon for the HP Utility in the
Dock.

Open HP Utility

To open the HP Utility
Click the HP Utility icon in the Dock.

NOTE: If the icon does not appear in the Dock, click the Spotlight icon on the right side
of the menu bar, type HP Utility in the box, and then click the HP Utility entry.

Embedded Web server
When the printer is connected to a network, you can use the embedded Web server to view status
information, change settings, and manage it from your computer.

NOTE: For a list of system requirements for the embedded Web server, see Embedded
Web server specifications.
To view or change some settings, you might need a password.
You can open and use the embedded Web server without being connected to the Internet.
However, some features are not available.

This section contains the following topics:
• About cookies
• To open the embedded Web server

About cookies
The embedded Web server (EWS) places very small text files (cookies) on your hard drive when
you are browsing. These files let the EWS recognize your computer the next time you visit. For
example, if you have configured the EWS language, a cookie helps remember which language
you have selected so that the next time you access the EWS, the pages are displayed in that
language. Though some cookies are cleared at the end of each session (such as the cookie that
stores the selected language), others (such as the cookie that stores customer-specific
preferences) are stored on the computer until you clear them manually.

98 Printer management tools



You can configure your browser to accept all cookies, or you can configure it to alert you every
time a cookie is offered, which allows you to decide which cookies to accept or refuse. You can
also use your browser to remove unwanted cookies.

NOTE: Depending on your printer, if you disable cookies, you also disable one or more of
the following features:

• Starting where you left the application (especially useful when using setup wizards)
• Remembering the EWS browser language setting
• Personalizing the EWS Home page
For information about how to change your privacy and cookie settings and how to view or delete
cookies, see the documentation available with your Web browser.

To open the embedded Web server

NOTE: The printer must be on a network and must have an IP address. The IP address and
hostname for the printer are listed on the status report. For more information, see Understand
the network configuration page.

In a supported Web browser on your computer, type the IP address or hostname that has been
assigned to the printer.
For example, if the IP address is 123.123.123.123, type the following address into the Web
browser: http://123.123.123.123.

TIP: If you are using Safari on a Macintosh computer, you can also open the EWS by
clicking the open-book toolbar button (located near the top of the browser window), clicking
Bonjour in the Collections list, and then selecting the printer name.

TIP:  After opening the embedded Web server, you can bookmark it so that you can return
to it quickly.
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